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0. FORORD

| dette kurset skal dere fa et godt grunnlag for & kunne lage en DAKmodell i Siemens PLM software NX.
DAK star for Datamaskinassistert Konstruksjon. Det er et nyttig verktgy for visuell modellering. Det finnes
mange forskjellige DAKprogrammer, grunnfunksjonene er de samme i de aller fleste. Kurset vil kun gi en
kort innfgring, s& noe selvstendig arbeid ma det bli. A bygge opp en modell kan gjgres pa mange mater,
men her blir det lagt vekt pa den enkleste oppbyggingen av modellen i forhold til metoden som skal
anvendes. | NX 7.5 er det en applikasjon som heter Synchronous Modeling, dette er en effektiv mate a
modellere pa, men dette vil vi ikke ga inn pa i dette kurset. Hoveddelene kurset vil ga igjennom er:

Geometriske figurer
Sammenstilling
Skisser

Ekstrudering
Datumplan

Tegning

R S S

For a gjgre det enkelt i forhold til de som er venstre hendte, eller hgyre hendte. Sa betyr fglgende for bruk
av musen:

+ MBI er hgyre museknapp for venstrehendte, og venstre museknapp for hgyrehendte.
4+ MB2 er midterste museknapp
+ MB3 er venstre museknapp for venstrehendte, og hgyre museknapp for hgyrehendte.

Hvis det er beskrevet slik at du skal merke noe, klikke og lignende, betyr det MB1.

File > New... betyr kommandoen ”New...” under rullgardinen ”File”.



1. LAGRINGSOMRADE

Fgrst ma du lage et omrade der du kan lagre delene dine. Datamaskinene pa skolen vil automatisk velge
lagringsomrade C:\UGS\NX6.0\UGII, der er det ikke lov a lagre filer, da man ikke har tilgang. Derfor ma
filene bli lagret pa et omrade pa en server. Hver student har fatt utdelt et serveromrdde som kun du har
tilgang til. Den ligger pa sambastud. Hvis omradet allerede er lagt opp pa maskinen din, kan du hoppe
over dette avsnittet.

e  Start = All programs > Accessories = Windows Explorer
Du har nda kommet inn i vinduet "Windows explorer” (Norsk: “Windows utforsker”).

e Velg "Computer” pa venstre side
e Velg knappen “Map Network Drive”

Du har nda kommet inn i vinduet "Map network drive” (Figur 1-1).
e  Skrivinn i Folder: ”\\webedit.ntnu.no\folk” (se Figur 1-1)

@ﬁ Map Network Dri

Enter Network Password
| What network folder would you like to map? Enter your password to connect to: webedit.ntnu.no

Specify the drive letter for the connection and the folder that you want to connect to:

‘ win-ntnu-no'\brukermavn

Drive [
Folder: webedit.ntnu.no\fol - Browse.. ‘ ‘ cesssass
Example; \\server\share | Domain: win-ntnu-no

[¥] Reconnect at logon Remember my credentials

[] Connect using different credentials ——

Connect to a Web site that you can use to store your documents and pictures.
| Insert a smart card

FIGUR 1-1 FIGUR 1-2

© Hvis du er pa en egen maskin, ma du definere brukernavnet ditt. Hvis du ikke er pd NTNUnettet, ma du :
- koble deg opp pa NTNUnettet via VPN. Hvis du er pa egen maskin ma du definere brukernavnet ditt slik:

e Merk av “Connect using different credentials”.
e  Trykk knappen “Finish”

: Du kommer nd inn i vinduet "Windows Security”.

e Skriv inn i Username: ”“win-ntnu-no\brukernavn”, der brukernavn byttes ut med ditt eget :
brukernavn du har pa NTNUnettet. :

e  Skrivinn i Password: passordet ditt du har til NTNUnettet.

e Trykk knappen ”OK”

e  Trykk knappen ”Finish”

N3a har du lagt opp nettverkskobling pa maskinen din. Hvis det er en datamaskin pa skolen, kan det vaere
at du ma gjgre dette hver gang du logger deg pa. Husk nar du lagrer, s3 ma du lagre pa serveromradet
ditt, slik at du finner igjen filen selv om du bruker en annen maskin neste gang. Nar du lagrer, unnga a
bruke tegnene &, @, og @ og mellomrom i filnavnet. Prgv og lag system i filene dine. Dette er treningssak,
men prgv a vaere bevisst, da er det lettere a skjgnne hva filen inneholder nar du skal finne den senere.



2. KETCHUPKORK

| dette kapittelet skal du lage en ketchupkork, og bruke den til 3 leere a

navigere i NX. Fgrst blir det litt oppvarming. Det blir ikke sa detaljert beskrivelse pa hvorfor du skal gjgre
det du gjgr. Neermere beskrivelse kommer i senere kapitler. For a lage korken, tar du utgangspunktet i en
sylinder, med en boss pa toppen som utgj@r toppen av korken, og sa hules halsen ut tilslutt.

Start NX 7.5
e Start > All programs 2> UGS NX 7.5 > NX 7.5

Du kommer na inn i vinduet NX 7.5.

Choose Hew File Hame

Mine dokumenine
Min datamirsion
. iy mg Eilnav Jeichupkoek] = oK
[——]—zx| r Mino Filype: PanFiles [ pi) = Abeyt |
FIGUR 2-1 FIGUR 2-2 FIGUR 2-3

Opprett fil
e  File > New... (CTRL + N)
Du har nd kommet inn i vinduet "New” (Figur 2-1).
e  Trykk knappen (Figur 2-2) til hgyre ved "Name”
Du har nd kommet inn i vinduet "Choose New File Name” (Figur 2-3).

e  Trykk pa knappen “Create New Folder”

e  Skrivinn ”NXkurs” som navn pa den nye mappen

e Dobbelklikk med MB1 pa den nye mappen, slik at du kommer inn i ”"NXkurs” mappen
e Skrivinn i ”File name” = "ketchupkork”

o Trykk knappen ”OK”

Du har na kommet tilbake til vinduet "New”.

e Velg "Milimeters” i rullgardinen ”"Units”, som befinner seg i omradet "Templates”
e Velg "Model” i omrédet “Templates”
e Trykk knappen ”OK”

Du kommer na inn i arbeidsvinduet i NX.

'._!i-’ NX 1.5 - Modeling - [ketchupkork. prt]

3 Eile Edit WVig] sert Format Tools

FIGUR 2-4



Hvis det star "Gateway” istedenfor "Modeling” gverst til venstre (Figur 2-4), er du i feil applikasjon. Da ma
du gjgre fglgende under:

: Duer nd i applikasjonen Gateway, og ma starte applikasjonen "Modeling”:

e  Start (Figur 2-5) = Modeling... (CTRL + M)

?‘j Startw

FIGUR 2-5

Roller @

Pa de fleste datamaskinene pa NTNU, er roller satt til agﬁ“m's(“mmed) , denne ma settes til gﬁ“‘”“"“‘”"”“.
Dette ma gj@res hver gang du starter NX, ellers vil du ikke finne mange av knapper og menyer.

e Ressursmeny (venstre side av skjermbildet) = Roles aﬂ - Advanced with full menus 2“
Modellering
Start med a lage sylinderen som blir selve halsen pa korken.

e Insert > Design Feature = Cylinder...
Du kommer na inn i dialogboksen ”Cylinder” (Figur 2-6).

e | seksjonen ”"Properties” fyller du inn fglgende:
O Diameter =9 mm
0 Height=9mm

e Trykk "OK”

X [Cyiinder

r
L. Be @ O8O 68 O Pw- =g,
L s LJI42P. @ QAER-G-R-B. ICHIEZ2L B
sl Aol [e ™

Type

I‘ﬁ Axis, Diameter, and Height us

EE@>E>§

Axis

@’Spemf\a Vector (1)

Reverse Direction

& Specify Point (1} bt
Dimensions .‘\.
Heih:
Boolean A
Boolear
Preview hd

}%-—![ Lpply ][ Cancel ]

i PANONNOS + 6 Y 3 T i o

FIGUR 2-6 FIGUR 2-7
Du kommer na tilbake til arbeidsvinduet i NX (Figur 2-7).
Na& ma du tilpasse vinduet, slik at sylinderen fyller vinduet.

e View - Operation > Fit (CTRL + F) eller trykk pa knappen “Fit” pa “View” verktgylinjen



N3 skal du lage toppen av korken ved a sette pa en boss.

e Insert - Design Feature = Boss...

Selection Steps

% Positioning

Filter o 1
Diameter = Salan
Height 2 mm_ L) t Expression
(4]
Taper Angle - mm |
Reverse Side

ok ) apply ] [ Cancel ) ook [ Avply | [“Back ][ Cancel ]
RRRRR———————————————————,,
FIGUR 2-8 FIGUR 2-9 FIGUR 2-10

Du har nd kommet inn i dialogboksen ”Boss” (Figur 2-8).

e Fyllinn fglgende i dialogboksen

0 Filter = Any

O Diameter =16

0 Height=2

O Taper Angel=0
e Trykk MB1 pa toppen av sylinderen i arbeidsvinduet
o  Trykk knappen ”OK”

Du kommer na inn i dialogboksen ”Positioning” (Figur 2-10).

+

. . v
e  Trykk ”"Point Onto Point” *

Du kommer na inn i dialogboksen ”Point onto Point” (Figur 2-11).

% | Set Arc Position x

End Point

® ' Point onto Point x

Name

[ J

[ Identify Solid Face ]

FIGUR 2-11 FIGUR 2-12 % FIGUR 2-13

e  Trykk pa sirkelen som kommer rundt bunnen av sylinderen (Figur 2-12)

| )
| |

Tangent Point

[oKk ][ Back || cancel |

Du kommer na inn i dialogboksen “Set Arc Position” (Figur 2-13).
e  Trykk knappen ”Arc Center”

Du kommer na tilbake til arbeidsvinduet i NX.

e  Trykk pa knappen O som du finner i nedtreksknappen i verktgylinjen “View” (se figur Figur
2-14) eller F7 pa tastaturet eller holde MB2 nede, og flytt pa korken ved & trykke ned MB1 i
arbeidsvinduet, sa du ser den pa skratt fra undersiden som i Figur 2-15 ved & holde MB1 nede.



Ble - S-O®e-0-v 6. 87 P
= fr Cul+f E"!@ : @”@E% -‘EE .@iw[

B FirView o Selection
D Zoom F& L
@, zoom In/Out |Boss(2)

L Pan
; Rotates the view by pressing M81 and dragging the
|2 EAEREE ‘ mouse. This command can alse be performed directly
using MB2

FIGUR 2-14 FIGUR 2-15

N3 skal du lage hullet i halsen, slik at den kan settes pa flasken.

|[|_| Grmeral Hale =
Pasitinn A
I & Speciy Rain (1)
Direction A
l Male Directicn
Form and Dimensions A
Fom 1) Simple E
A O
Bepth Limie i rd |

BEnolean
Boolean
W SelectBody (1)
Senings v
Freview ¥
==le el
FIGUR 2-16 FIGUR 2-17 FIGUR 2-18

Until Selected
Until Next i
Through Body

FIGUR 2-19 FIGUR 2-20 FIGUR 2-21

Boolean

e  Trykk pa knappen "Hole” ’:I pa verkgylinje ”Feature”
Du har nda kommet inn i dialogboksen “Hole” (Figur 2-16).

e Fyllinn fglgende i dialogboksen
0 Type ="General Hole”



0 Form ="Simple”
O Diameter=6
0 Depth Limit = "Until selected”

Position

A
= e
e Velg "Specify point” i dialogboksen “Hole”. B B
e Trykk pa flaten i bunn av korken, der hullet skal plasseres (Figur 2-17)
e  Trykk pa knappen "Close” i dialogboksen ”Sketch point” (Figur 2-18)
o Dobbelklikk med MB1 (venstre musetast for hgyrehendte) pd dimensjonene, og gi dem
dimensjonen ”0”, slik at hullet blir merket (”Point”) kommer i senter (Figur 2-19).

inish Sketch
e Trykk knappen ”"Finish Sketch” B8 Fiish skesc
e  Pass pa at "Depth Limit” i dialogboksen "Hole” er satt til “Until Selected” (Figur 2-20).

Dimensions A

Diameter mm r!

Depth Limit IUnt\I Selected EVJ
* Select Object {0)

e Velg "Select Object” i dialogboksen “Hole”.
e Velg flaten som vist i Figur 2-22.
e  Korken skal se ut som Figur 2-21, fgr du trykker knappen "OK” i dialogboksen "Hole”.

FIGUR 2-22

Du kommer na tilbake til arbeidsvinduet i NX.
Avslutte

e  File = Save (Ctrl +S)
e File > Close = All Parts



3. NAVIGERING

| forrige kapittelet laget du en ketchupkork, den skal du na bruke til 3 lsere & navigere deg i NX.

: Applikasjoner

= Programmet NX er bygget opp i mange applikasjoner (“application”), disse finner du pa startknappen =
w' Skart -

. . En applikasjon i NX er et underprogram. NX er bygget opp slik, fordi hele programmet er sd _
~ stort at det vil gjgre datamaskinen treg hvis hele programmet skulle kjgres under ett. De tre
. applikasjonen du skal se pa i dette kurset er:

Gateway — lar deg dpne deler, og gjgre noen fa enkle funksjoner
Modeling — lar deg lage deler, overflater og kurver
Drafting — lar deg lage arbeidstegninger

—_—_—— — - —_—— —_— e —_— e — e —_— e — e —_— e —_ e —_— e —_— e — e —— e —— i —— e — e — o

| dette kurset skal du bruke mest "Modeling”. Na skal du hente inn ketsjupkorken du lagde i forrige
kapittel. Hvis du ikke har begynt NX 7.5 ma du starte opp denne fgrst.

= #

e  File = Open (Ctrl + O)

Du kommet na inn i vinduet "Open” (Figur 3-1).
Jid

FIGUR 3-1

e Velg "ketchupkork.prt” (den du nettopp har laget og lagret i mappen NXkurs pa ditt
hjemmeomrade)
e  Trykk knappen ”OK"

Du kommer na inn i arbeidsvinduet i NX. Ketsjupkorken skal na dukke opp i arbeidsvinduet.

: Du skal komme direkte inn i applikasjonen “Modeling”, men hvis du har varmstartet NX, sa vil du kanskje :
- komme inn i “Gateway” applikasjonen. Da ma du gjgre fglgende. :

e  Start 2 Modeling (Ctrl + M).

Hvis du ikke finner “Modeling”, er det fordi du allerede er inne i modelleringsapplikasjonen.

10



" Ressursmeny (Resource bar)

= Denne ligger pa venstre side av vinduet. Her skal vi se pa fire deler:

= 4+ Assembly navigator

4+ Part navigator

4+ History

4+ Roles

Roller (Roles)

Roller er plassert i ressursmenyen (Resource bar) som er pa venstre side i NX vinduet. Hvis du starter NX
pa en skoledatamaskin, sa vil roller vaere automatisk satt til “Essentials”. Da vil du kun fa de aller mest
brukte funksjonene. Dette kan vaere nyttig hvis man synes NX har for mange funksjoner. Na skal du velge
en rolle som gir deg fullstendige menyer. Gjgr dette hver gang du starter en skoledatamaskin.

e Resource bar = Roles = System Defaults = Advanced with full menus [Dobbelklikk]

Fole
Advanced with Full menus

Du kan na fa opp informasjon om at du vil overskrive alle dine innstillinger, og at det er muligheter for a
lagre disse instillingene hvis du vil. For a ga videre uten a ta affaere, skal du trykke "OK”.

e  Trykk knappen “OK”

" Fra ressursmenyen kan du bruke flere metoder for 3 aktivisere ting som:

. + Marker, flytte ikonet og slipp ikonet med musen pa det du vil skal aktiviseres .
4+ Dobbeltklikk
- + MB3 - Apply -

NX tilpasser menyer og knapper ut ifra den rollen du skal ha, gnsker du ikke dette velger du “Advanced
with full menus”. NX har en del standardsettinger for knapperader, menyer osv. Dermed kan du tilpasse
vinduet ditt akkurat slik du gnsker med knapperader, starrelse pd knapper osv, slik at du vil bruke NX mer
effektivt. Det er ogsa fullt mulig a lage sine egne roller, og a importere forhandslagede roller, men det skal
vi ikke ga inn pa i dette kurset. Na skal vi bruke rollen "Advanced with full menus” som du nettopp har
valgt.

Sammenstillingsnavigator (Assembly navigator)

Denne brukes nar du skal sette flere deler sasmmen. Nar du f.eks skal sette en aksel inn i en kloss, sa kan
du navigere mellom delene ved a dobbelklikke pa delen i "Assembly navigator”. Her ser du hvilke deler
sammenstillingen bestar av. Etter du har laget en stgrre sammenstilling en gang, sa er det nyttig a
utforske mulighetene i denne navigatoren, det kan lette mye arbeid senere.

11



Delnavigator (Part navigator)

Her kan du navigere deg igjennom den delen du har laget. Alt du har gjort med a bygge opp delen vil bli
vist her. Dette er historietreet til delen. Tallene i parentes forteller rekkefglgen av funksjoner delen er
bygget opp av.

e Resource bar 2 Part Navigator
e  Trykk pa krysset foran “Model history (kryss foran, sa du far fram deltreet)

41 Part Navigator
Name o Comment

€5 History Mode

& Eﬂ Model Views

- [%h Cameras

25 Model History
b Datum Coordinate Sy...
W @ Cylinder{1}
A Boss (2 =
W simple Hole {3

FIGUR 3-2 B

<+ De elementene du har lagt til, er merket med tall bak seg(0, 1, 2) i rekkefglgen de er laget.

£ Ved & dobbeltklikke pa de enkelte kommandoene som har blitt gjort, sd kan du endre de.

% Gjgre elementene synlig eller usynlig, og vil ikke fungere. Nar det er en grgnn hake, er de synlig.
Ved 3 trykke pa haken merkes den eller fjernes.

+ Du kan ha vinduet sta fast dpent ved a trykke pa tegnestiften gverst til venstre.

Historie (History)

Her ser du alle de delene du har apnet og jobbet med den siste tiden. Den sorterer pa Today, Last week
osv. Ved a dobbeltklikke pa ikonet eller dra det inn i vinduet, vil du dpne gjeldende del.

Verktgylinjen (Toolbar): View

Denne finner du gverst midt pa siden. Hvis den ikke er der, ma du velge rollen “Advanced with full
menus”.

e  Fgr musepekeren pa et verktgylinjeomrade uten verkgylinje (gratt felt)
e MB3
e  Trykk ”View”, denne skal sta avmerket

12
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FIGUR 3-3

1 2 3 4 5 6 7 8 9

"View” nedtreksmeny, her kan du tilpasse og plassere delen i arbeidsvinduet.

”QOrientation” nedtreksmeny, her kan du orientere delen fra de vinklene du gnsker.

”Face” nedtreksmeny, her kan du velge hva slags overflate du gnsker & se modellen i.
"Wireframe Contrast”, gker kontrasten ved visning med tradgrafikk.

”See Thru”, viser mindre viktige overflater med gjennomsiktighet.

”See-Thru Shell”, viser mindre viktige overflater med gjennomsiktighet med en bestemt farge.
”Light background”, forandrer utseende i bakgrunnen i arbeidsvinduet.

”Clip Work Section”, skrur av og pa snitt.

"Edit Work Section”, angir snitt.

LNV R WNRE

+ F6 og F7 er funksjonsknappene pa tastaturet. De vil bare aktivisere funksjonen av
musemarkgren akkurat som a trykke pa punkt 1.

4+ Ved siden av ikonet til punkt 3 er det en pil, da kan du velge forskjellige typer “shading”,
overflater. Det kan veere praktisk a velge "wireframe” nar man skal se under en overflate.

4+ Ved siden av ikonet til punkt 2 er det en pil, da kan du velge forskjellige vinkler a se delen fra.

+ Ved 4 holde MB3 og holde musen i ro i 2 sekunder, s& vil du fa fram muligheter for & velge Punkt
1og3.

Merking

[~ [NoSelection Filter o) [Entire Assembly vl 8 | Fl- 0 &% % [ -

FIGUR 3-4

”General selection filters” finner du pa nederst pa knapperadene. Her kan du velge hva du skal velge og
hva du skal merke. Ved a sette ”Selection type filter” til "Edge”, sa vil du kun fa anledning til bare & merke
kantene. Denne er praktisk ved store deler.

+ For a fa fjernet det som er merket, kan man trykke pa ESC knappen pa tastaturet. Da vil du fa
fiernet alt merket omrade. ESC knappen finner du gverst til venstre pa tastaturet, ESC star for
escape.

4+ Det er ogsa mulig @ holde MB1 nede og merke et omrade, da vil alle elementer som er inne i
kvadratet som blir dratt opp med musen bli merket. Det er ogsa mulig 3 merke ved a trykke pa
overflater eller linjer. Ved a holde shiftknappen nede nar man merker vil man ogsa kunne fjerne
merkingen. Shiftknappen finner du ytterst til venstre og hgyre side pd nest nederste rad pa
tastaturet.

4+ Ved hjelp av Part Navigator kan du ogsa ga inn i deltreet og markere et av elementene ved 3
trykke pa den. Da vil delen bli merket.

High quality image
Nar du skal ta ut et fotografisk bilde av delen, sa trenger du en hgyoppl@sning.

e View = Visualization = High quality image (Ctrl + Shift + H)

13



~ High Quality Image x|
Method Photo-Realistic E e anmi
Save File
[T
Eln]E :
IX: \NxXkurs\ketchupkork.tif
l List Files
start Shade M {Compress mage

[-ok 1| Back || cancel | [-—ok || Back || Cancel |

FIGUR 3-5 FIGUR 3-6

Du har nd kommet inn i dialogboksen ”High quality image” (Figur 3-5).

e  Trykk knappen “Start shade”
e  Trykk knappen “Save”

Du har nd kommet inn i dialogboksen ”Save Image” (Figur 3-6).
e  Trykk knappen “List files”
Du har nd kommet inn i vinduet “Save Image” (Figur 3-7).

e G3inn pa hjemmeomradet ditt og inn i katalogen "NXkurs”
e  Skrivinni Filnavn: “"ketchupkork.tif”
o  Trykk knappen ”OK”

Du kommer na tilbake til dialogboksen ”Save Image”.

e  Merk av boksen “Compress Image”
o Trykk knappen ”OK”

Mine deiemariz

8

Mincatamaskin

L

T

FIGUR 3-7

Du har na lagret bildet pa ditt hjemmeomradet i katalogen NXkurs, du har nd kommet tilbake til

dialogvinduet "High Quality Image”. For 3 komme ut av denne funksjonen gjgr du:

e  Trykk knappen ”OK”

Du kommet na tilbake til arbeidsvinduet i NX.

[ VisualizeShigpe x|
@Yot dNeYe ng

FIGUR 3-8

el

FIGUR 3-9

FIGUR 3-10

"Visualize shape” verktgylinjen (Figur 3-8) som dukket opp kan du bruke til & forandre utseendet. Det kan
vaere lurt @ navigere delen slik at du far mest mulig informasjon ut av bildet.

e Ved atrykke ”Start Shade” (Figur 3-9) pa verktgylinjen ”Visualize shape”, rendrer NX bildet.

e Ved a trykke ”"Erase Shade” (Figur 3-10) pa verktgylinjen ”Visualize shape”, fjerner den

rendringen i bildet.

o Lukk "Visualize shape” verktgylinjen ved a trykke pa X gverst til hgyre i vinduet

Lag (Layer)

Lag er et sveert praktisk verktgy i NX. Dette lar deg sortere elementer, skisseplan, datumplan osv i
forksjellige lag (datumplan kommer du tilbake til). Hvis du ser for deg at du har en tegneblokk bestdende
av bare lysark (overheadfoiler). For a tegne en kompleks del, sa tegner du de forskjellige elementene i
forskjellige plan, det samme gjelder hjelpelinjer du vil trenge. Sa kan du ta ut og inn ark, og ved hjelp av

kombinasjonen av forkskjellige ark du har sammen, sa vil du tilslutt fa fram den delen du vil tegne.
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Alt du har laget hittil er blitt lagt til i lag 1, som da har vaert arbeidslaget. Det er bare mulig a lage deler i et
lag omgangen. Na skal du flytte ketchupkorken fra lag 1 til lag 2, og se hva som skjer da.

e Format - Move to layer ...

W [Layer Move |§ W[ Layer Settings
) Find Layer from Object 7
Destination Layer or Category r 1
{2 ] Select Object 0/ |:¢-—|
Caegorysier [v | ok Lver 4l
% Class Selection =% Curves bl gl
Datums Lmyers A
r Sheets r 1
Objects A Sharchios selectiaversyRangescumegery [
Solids [T cateary Cinplay
* Select Objects (0)
. Layer [ Mame & Wisible Geby O
Select All 4 1 Work 1
. 51 Selzcrable - K o
Invert Selection @ =B =
Other Selection Methods A
L=
l‘ - 2 1
Show
[ Re-highlight Objects | 2dd Catagery
Filters v [ Select New Objects | | Layer controt ¥
bettings v
o) [y ) (et ) —
FIGUR 3-11 FIGUR 3-12 FIGUR 3-13

Du har nd kommet inn i dialogboksen ”Class selection” (Figur 3-11).

e Trykk pa ketchupkorken i arbeidsvinduet
o  Trykk pa ”OK”

Du har nd kommet inn i dialogboksen ”Layer move” (Figur 3-12).

e  Skrivinn ”2” i "Destination Layer or Category”
e  Trykk knappen “OK”

Ketchupkorken har du flyttet til lag 2. Lag 2 er kun et klikkbart lag, men alt du foretar deg na blir
fremdeles laget i lag 1. Na skal du lage lag 1 til arbeidslag.

e Format = Layer settings... (Ctrl+L)
Du har nd kommet inn i dialogboksen ”Layer settings” (Figur 3-13).

e  Skrivinn”2” i ”Work Layer” i omradet "Work Layer”
e  Trykk "Enter” pa tastaturet
e  Trykk knappen ”Close”

Du kommer na tilbake til arbeidsvinduet i NX. Na har korkens lag blitt arbeidslaget, og alt det du gjgr vil bli
lagt i det laget.
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Avslutte
e File > Close = All Parts...
Du kommer na inn i “Close all Parts” vinduet (Figur 3-14).

’f ‘You hawe an open file that is modified,
L

o ft it bef losing? " Are you sure you wank ko save the files?
0 you want to save it befare dosing? Ll

ketchupkork.prt DDon't display this message again
[ ves-Saveand Close [ Mo - Close ] [ Cancel ] Fves— - Ho
FIGUR 3-14 FIGUR 3-15

e Trykk knappen ”Yes — Save and Close”
Du komer na inn i “Save” vinduet (Figur 3-15). Bekreft at du har lyst til & lagre disse filene.

e  Trykk knappen “Yes”

16



4. DREIEBOLT “

| dette kapittelet skal du lage en dreiebolt, ved hjelp av en enkel /

eksisterende geometri, og sa skal du legge pa en boss. Du skal i tillegg
lage en skrdkant pa bossen. Og gjenge den halvveis inn.

Na skal du lage filen dreiebolt.prt i NXkurs mappen, og velge malen ‘&
("Templates”) “Model” fordi det skal vaere en enkel kun en enkel
modell, og den skal bruke enheten millimeter.

e  File > New... (Ctrl+N)

Du har na kommet inn i vinduet "New” (Figur 4-1).

e Fyllinn fglgende i vinduet
0 Under omradet "New File Name” fyller du inn i ”"Name” = dreiebolt.prt
0 Under omradet "New File Name” velger du i "Folder” = NXkurs
0 Under omradet "Templates” velger du "Model”
0 Under omradet "Templates” velger du i ”Units” = Millimeters
e  Trykk knappen "OK”

Tope A
[ %8 sis, Diam ever, and ieighe =]
Axis A |
I 1
+ Specity Vectar (1} [ el
Reverse Direcrion A
W Specify Peint (1) (| # ™
Dimensions Al
Dianster 2] on 8
Height 100 - W
Enalean A
Boalean g Hone =
Preview v
K Apply [= |
= | J[ apphy ancel |
FIGUR 4-1 FIGUR 4-2

Du har nd kommet inn i arbeidsvinduet i NX.
Pinnen

Du starter med & lage en pinne som blir laget av en sylinder. Denne sylinderen skal etterhvert fa et hode
som utgj@r toppen av dreiebolten.

e Insert - Design Feature = Cylinder...

Du kommer na inn i dialogboksen “Cylinder” (Figur 4-2). Her lages sylinderen ut ifra akse, diameter og
hgyde. Aksen kan spesifiseres plassering under seksjonen ”Axis”, mens diameter og hgyde spesifiseres
under “Dimensions”.

e | seksjonen “Dimensions” fyller du inn fglgende:
O ”Diameter” =10 mm
0 "Height” =100 mm

e  Trykk knappen ”OK"

Du kommer na tilbake til arbeidsvinduet i NX. For & fa plassert sylinderen til a fylle arbeidsvinduet og fa
rett plassering, kan man sette den i standard plasseringsvinkel "Trimetric”.

e Verktgylinjen View, trykk “Trimetric” (HOME)
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Boss
Na skal du lage toppen av dreiebolten, som blir plassert pa toppen av pinnen.
e Insert - Design Feature = Boss...

Du kommer na inn i dialogboksen “Boss” (Figur 4-3).

Selection Steps
Filter
% Positioning
Diameter
s R ==

Taper Angle 4 . -
Current Expression Paint onto Point]

Reverse Side
| = | mm |

ok [ oy | ok ] [ancar)

FIGUR 4-3 FIGUR 4-4 FIGUR 4-5

[ ok || apply || cancel |

e  Marker toppen av sylinderen som star i arbeidsvinduet i NX (Figur 4-4)
e  Fyllinn i dialogboksen “Boss”

O ”“Diameter” =15 mm

O "Height” =10 mm
e  Trykk knappen ”OK”

% 'Point onto Point % ' Set Arc Position

Identify Solid Face Tangent Point

o) ek (e

FIGUR 4-6 FIGUR 4-7 FIGUR 4-8

Du kommer inn i dialogboksen ”Positioning” (Figur 4-5).

*

e Velg "Point onto Point” <
Du kommer inn i dialogboksen”Point onto Point” (Figur 4-6).
e Velg den nederste kanten av sylinderen (Figur 4-7)
Du kommer inn i dialogboksen ”Set Arc Position” (Figur 4-8).
e Velg knappen ”Arc Center”

Du kommer na tilbake til arbeidsvinduet i NX, og bossen blir plassert i senter pa toppen av sylinderen.
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=

FIGUR 4-9 FIGUR 4-10 FIGUR 4-11

S n

e Trykk pa "Rotate” pa "View” verktgylinjen eller trykk F7

Plasser musepekeren midt pa venstre side i arbeidsvinduet (Figur 4-9), til det komme en horisontal akse
pa musepekeren, trykk ned MB1 og dra musepekeren oppover slik at du far vippet bolten slik som i Figur

4-10.

e  Trykk ESC pa tastaturet for 3 komme ut av “Rotate” funksjonen

o

e Trykk "Zoom” pa "View” verktgylinjen eller trykk F6

Merk av den nederste delen av pinnen (motsatt side av bossen), ved a tegne et rektangel rundt den delen

av pinnen. Trykk MB1 ned og hold den nede, tegn et rektangel, og slipp MB1 (Figur 4-11).
e  Trykk ESC pa tastaturet for 8 komme ut av "Zoom” funksjonen

Skrakant (Chamfer)

Na skal du lage en skrakant nederst pa pinnen, fgr den skal gjenges.
e Insert - Detail Feature > Chamfer...

Du kommer nd inn i dialogboksen ”"Chamfer” (Figur 4-12).

[\ "Chamfer
Edge A
+" Select Edge (1)
Offsets A
Cross Section Offset and Angle E’v‘a
Distance 1.9 mm %)
Al 45 [degig
Reverse Direction ;\’
Settings v
Preview v

[—ok—][ Apply |[ cancel |
FIGUR 4-12 FIGUR 4-13

e Fyllinnidialogboksen “Chamfer” i seksjonen ”Offsets”
0 Velg "Offset and Angle” i rullgardinen for “Cross Section”
0 "Distance” = 1.5 mm (NX bruker punktum og ikke komma som desimalskille)
0 ”"Angle” =45 deg
e Velg endeflaten nederst pa sylinderen, som er pa motsatt side av bossen (Figur 4-13)
e  Trykk knappen “OK”

Du returnerer na til arbeidsvinduet i NX.

A
e  Trykk knappen "Fit” pa verktgylinjen "View”
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Gjenger (Threads)
Na skal du lager gjenger halvveis inn pa pinnen.
e Insert - Design Feature = Thread...

Du kommer na inn i dialogboksen “Thread” (Figur 4-14).

% Thread

I

Thread Type
() symbolic () Detailed

Major Diameter mm |

Minor Diameter 8.5 mm
Length 0 mm
Pitch mm ]

i
n

Angle 60 deg

Rotation % Thread
(® Right Hand

() Left Hand

]

| Select Start

o) ooy ) (e

FIGUR 4-14 FIGUR 4-15 FIGUR 4-16

e Velg radioknappen “Detailed” i omradet “Thread Type”
e Velg sylinderen i arbeidsvinduet (Figur 4-15)

Du kommer na inn i dialogboksen “"Thread” (Figur 4-16), som spgr hvor gjengene skal starte fra.
e Velg enden av sylinderen pa motsatt side av "bossen”.

Du kommer na til dialogboksen "Thread” (Figur 4-18), som spgr om du skal bytte ende gjengene starter
fra. Pilen peker den retningen gjengene starter fra (Figur 4-19).

e Trykk “Reverse Thread Axis”, hvis vektorpilen gar ut av sylinderen
o  Trykk knappen ”OK"

% Thread

Reverse Thread Axis

Start Conditions

[ok—|[ Back || cancel |

FIGUR 4-17 FIGUR 4-18 FIGUR 4-19



Du kommer na tilbake til dialogboksen “Thread” (Figur 4-14).

e  Fyllinn dialogboksen “Thread”
0 "Length” =50 mm
o  Trykk knappen “OK”

Du returnerer til arbeidsvinduet i NX.

Kantbgyning (Edge blend)

Na skal du lage en avrundet kant pa “Bossen”.

e Insert - Detail Feature - Edge Blend...

Du kommer na inn i dialogboksen “Edge blend” (Figur 4-20), du ma merke den kanten du gnsker skal
avbgyes.

Edge to Blend A
& SelectEdge (1)
‘Radius 1 2o nn
Add New Set
LLisl v
Variable Radius Points | v|
Corner Setback v
Stop Shart of Corner v
Trimming v
Overflow Resolutions v
Settings v
Preview v
[ =ok> || apply |[ cancel
FIGUR 4-20 FIGUR 4-21

e  Merk av toppen pa kanten av bossen (Figur 4-21).
e |seksjonen ”"Edge to Blend”, fyller du inn “Radius 1” = 2.5 mm
o Trykk knappen ”OK”

Og du returnerer til arbeidsvinduet i NX.

* Geometrisk figur

Da du lagde sylinderen, brukte du en geometrisk figur. NX har fire forskjellige geometriske figurer:

=+ Kule
: 4+ Konisk :
i = Sylinder i
% Blokk )

= Alle finner du under ”Insert = Design Feature”. Slike figurer er noe som henger igjen fra tidligere
DAKprogrammer. Og i NX kan du kun bruke en geomtrisk figur pr del. Hvis du bruker flere, vil du fa et

= mellomrom i figurene som du ikke vil klare a fylle. Dermed er det lurt 3 bruke sketch, som du skal leere
om i kapittel 5. | neste kapittel skal du leere om a sette to deler sammen.

Avslutt

e  File = Save (Ctrl+S)
e  File 2 Close = All parts
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4,1. TRENINGSOPPGAVER

Oppgave 1
Modeller denne ved hjelp av
sylinder, “boss” og hull.

Oppgave 2

Modeller denne ved hjelp av
sylinder, “boss”, hull og “groove”.
"Groove” er et innvendig spor, som
ma plasseres inni i hullet. Tips til
formen av "Grooven” er hvordan
sporet ser ut. Hullet lages fgrst,
med endevinkel 0°. S& plassers
"Grooven” ved fgrst a velge kanten
av sylinderen den skal male fra
("target edge”), og sa merke
”Groovens” kant ("tool edge”).
Dette skal veere 18, som gitt pa
tegningen. Velg "Wireframe” som
visningsform, hvis det er vanskelig
a velge kantene.

Oppgave 3

Modeller denne ved hjelp av blokk
og ”slot”. Dimensjonene pa
blokken er 60 x 90 x 30.
Dimensjonene pa svalehalesporet
er 30 x 12 x 60°.
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5. FYRSTIKKESKE

I denne gvingen skal du lage en fyrstikkeske. Den er satt sammen av to
deler, en skuff og boks. Du skal bruke to geometriske figurer pa begge
deler, og hule de ut. Etterpd skal de settes sammen ved & bruke

”Assembly” funksjonen. For at de skal passe sammen, sa skal du ta i bruk ”Expression” for & knytte

stgrrelsene mot hverandre.

® Litt teori: Gylne rektangel

= Veldig enkelt forklart, sa har det gylne

rektangel et forholdstall. Forholdstallet er =

1,6180339887498948482..., som er forholdet mellom bredde og lengde. Dette forholdet finner du igjen

= pa et A4 ark, fyrstikkeske osv. Fyrstikkesken

har en bredde pa 36mm, og lengden er:

1,618x36=58,248mm. Hgyden pa fyrstikkesken er halvparten av bredden.

Gylne rektangel skal vi bruke for a lage esken.

Na skal du lage filen fyrstikkeske_boks.prt i NXkurs mappen, og velge malen ("Templates”) "Model” fordi
det skal veere en enkel kun en enkel modell, og den skal bruke enheten millimeter.

e  File 2 New... (Ctrl+N)
Du har na kommet inn i vinduet "New” (Figur 5-1).

e Fyllinn fglgende i vinduet

0 Under omradet "New File Name” fyller du inn i "Name” = fyrstikkeske_boks.prt
0 Under omradet "New File Name” velger du i “Folder” = NXkurs

0 Under omradet "Templates” velger du "Model”

0 Under omradet "Templates” velger du i “Units” = Millimeters

e  Trykk knappen "OK”

Herw =

drawing | Simataniea | aecfactunng [ spacnsa | uachassss Conceps Dangas]

| Preveew ~

N .n]_

Cramer

| pregs &

|| Mame: woder

| | Trpe: sdeling

|| unite: tien ooy
aeeMadfied G4/11/2018 1241
Descripnon: X Example wich dasem CST5

Pew File Hame A

Mane |fyratikkeske baks.prt

FIGUR 5-1

Du har nd kommet inn i arbeidsvinduet i NX.
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I—Q-K—l [ Apply ] [ Cancel ]
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Expressions

For @ malsette deler finnes det faste og variable stgrrelser. En lengde kan fa en konstant dimensjon, eller
bli gitt en funksjon av andre stgrrelser. En boks kan bli definert med en lengde, og bredde som er
halvparten av lengden. Det er fullt mulig a lage en del med kun en konstant, og resten med funksjoner av
konstanten. N3 skal du legge inn verdiene for esken.

e Tools = Expression... (Ctrl+E)

Du kommer na inn i dialogboksen “Expressions” (Figur 5-2). Du skal na angi en definisjon, som sier bredde
=36 mm.

e Fyllinn i dialogboksen ”Expressions”
0 ”“Name” = bredde
0 "Formula” =36 mm

o Trykk

Videre skal du lage de fire andre stgrrelsene. Du skal ha bredde, hgyde, lengde og tykkelse. | NX er det
ikke mulig & bruke "z, ¢ og a@” i navnet eller andre referanser. En god regel er alltid @ bruke vanlige
engelske bokstaver uten mellomrom, bruk understrek (“underscore”) som mellomrom. Na skal du lage
lengde og bredde ut ifra to formler som referer til det gylne rektangel.

Fyll inn i dialogboksen ”Expressions”, der lengde er ”1,618 X bredden” til fyrstikkesken, hgyden er
halvparten av bredden, og tykkelsen er 1 mm.

e Fyllinnidialogboksen “Expressions” for stgrrelsen “lengde”
0 “Name” =lengde
0 "Formula” = bredde*1.618

e  Trykk

e Fyllinn i dialogboksen “Expressions” for stgrrelsen "hgyde”
0 ”Name” = hoyde
0 ”"Formula” = bredde/2

e Trykk

e Fyllinnidialogboksen “Expressions” for stgrrelsen “tykkelse”
0 ”Name” =tykkelse
0 “Formula” =1

e  Trykk

e  Trykk knappen ”OK”

Du returnerer til arbeidsvinduet i NX. Det beste hadde vaert a sette konstanten til det gylne rektangel som
en referanse, istedenfor a legge den inn i mange av uttrykkene.

Blokk

Na skal du lage en blokk, som bruker de dimensjonene som ble fastsatt i “Expressions”. Istedenfor a taste
inn en verdi pa lengde og bredde, sa legger du inn navnet pa uttrykket for lengde, bredde og tykkelse.

e Insert > Design Feature - Block...
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Du kommer inn i dialogboksen ”Block” (Figur 5-3).

= A . e CPA T PeL e Ty T A]
5 g s Edge Lon 7] | _'_j-_ L3 ez - 3
Orvegen s B = ~
o Spacify Polet 1) EW‘ i E
Damensions A ,'
Lengih (¢) [lengie  nm I 3
Wdth (VE1 [reraar we Ci
Helga Z0) [royse mm W) e
Boolean A |
e [ wome Ml
Preview v
FIGUR 5-3 FIGUR 5-4
e Fyllinni dialogboksen “Block”

O “Type” = Origin and Edge Lengths
0 “Length (XC)” = lengde

0 “Width (YC)” = bredde

0 “Height (ZC)” = hoyde

Trykk knappen ”OK”

Du returnerer til arbeidsvinduet i NX, og tilpass boksen til vinduet.

View = Operation - Fit

" Blokk "Block”

+

"Type”, er hvilke vinkler og punkter du
skal lage boksen ut ifra. Enten fra origo til
kantlengde, eller fra to punkter og hgyde,
eller boks ut fra to diagonale punkter.

Dimensjonsboks, her setter du inn verdien
tii  dimensjonene, eller navnet pa
uttrykket som gir en dimensjon. Disse
varierer ut ifra hvilken "Type” som er
valgt.

T~

”"Boolean Operation”, betyr om

elemtentet skal innga i eksisterende figur, _ ____——»
lages som en helt ny osv, du far mer

forklaring pa dette senere.

|_
Type M
[D Origin and Edge Lengths @
Origin A
4" Specify Point (1) ’,ﬁ' 1
Dimensions A
Height {ZC} hoyde mm .
Boolean A
Preview v
I—.Blév—l [ Apply ] [ Cancel ]

Skall

N3 skal du hule ut boksen. Her kan du velge mellom om delen skal hules ut inni, eller at enkelte sider skal
fiernes sa den far en eller flere apne sider. Den er automatisk satt til @ hule ut ved & fjerne en eller flere

sider.
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Du kommer nd inn i dialogboksen ”Shell” (Figur 5-5).

| Type

x

| | [ Remove Faces, Then Shell =
[\ Face to Plerce Al
{.?clséeme =]
Thickness Al
Reverse Direction #
| Altemnare Thickness v
| Settings v ‘
| Preview > L
ok [“Apply | ["Cancel |
FIGUR 5-5 FIGUR 5-6 FIGUR 5-7

Velg fra seksjonen “Type”
0 Funksjonen “Remove faces, then shell”

e Fyllinniseksjonen “Thickness”, der skal du referere til det du skrev i “Expression” med tykkelse

0 "Thickness” = tykkelse

e Merk bredde/hgyde siden av boksen (Figur 5-6)

e Merk den andre bredde/hgyde siden pa motsatt side av boksen (Figur 5-7) (Du kan rotere pa
boksen ved a trykke F7 eller holde MB2 nede og rotere pa boksen)

e  Trykk knappen ”OK”

Du kommer na tilbake til arbeidsvinduet i NX, orienter boksen i Trimetric vinkel.

e Toolbar View = "Trimetric (Home)” (Figur 5-8)
e File > Save (Ctrl+S)
e File 2 Close = All Parts

FIGUR 5-8

skuff

Na skal du lage skuffen til fyrstikkesken. Den bestar av boks, der skallfunksjonen brukes for @ hule ut
boksen, og at toppflaten blir fijernet.

Na skal du lage filen fyrstikkeske_skuff.prt i NXkurs mappen, og velge malen ("Templates”) "Model” fordi
det skal veere en enkel kun en enkel modell, og den skal bruke enheten millimeter.

e  File > New... (Ctrl+N)
Du har nd kommet inn i vinduet ”"New” (Figur 5-9).
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e Fyllinn fglgende i vinduet
0 Under omradet "New File Name” fyller du inn i “Name” = fyrstikkeske_skuff.prt
0 Under omradet "New File Name” velger du i “Folder” = NXkurs
0 Under omradet "Templates” velger du “Model”
0 Under omradet "Templates” velger du i “Units” = Millimeters
e  Trykk knappen "OK”

Du kommer na inn i arbeidsvinduet i NX.

T 5 I~ [Expressions ﬁ
Listed Expressions ]
1Naned E"} B
Name & Formula Value Units Type Comment Che
bredde _skuff Fyrstikkeske_b... 34 mm Number
hoyde_skuff Fyrstikkeske_b... 16 mm Number
lengde_skuff fiyrstikkeske_b.. 58.248 mm Mumber
tykkelse_skuff fyrstikkeske_b.. 1 mm Number
Pusperies A
tame Madel
Type Madeleg
Unizs: Milic eters
Last Modiied 02715/2000 1243 .
Davengtise: W Cokn e with datum 475 hS >
E—— Al TvDe!Nunher _EV 3 ILength m
Mime [fyestakkeske skuff.pee [_‘| Namel Hr.m a
Folder 22\ Uikure |—'| FDrr‘\uIaI ] 7 | K
5 I =t
| @ HEREEE
E oK H Apply - ![ Cancel ]
| o
FIGUR 5-9 FIGUR 5-10
Expressions

Na skal du hente inn de verdiene fra esken, for a lage stgrrelsene til skuffen.
e Tools = Expression... (Ctrl+E)
Du kommer na inn i dialogboksen "Expressions” (Figur 5-10).

Du skal lage en formel som ser slik ut:

Fyrstikkeske_boks::bredde-2*Fyrstikkeske_boks::tykkelse

Boksen har en breddedimensjon
med tykkelse, og da vil skuffen Fyrstikkeske boks::tykkelse er
vaere bredden minus to tykkelsen fra delen boks.
tykkelser.

Fyrstikkeske_boks::bredde er
= bredden i uttrykket som du laget
i filen ”Fyrstikkeske_boks”.

Formelen forteller at skuffens bredde ma vaere to ganger tykkelsen til veggen av boksen mindre av
boksen, fordi skuffen ma kunne gli innenfor boksens vegger. Skuffen er like lang som boksen, fordi der er
boksen apen i begge ender. Dette gjgres pa fglgende mate:

e  Fyllinn i dialogboksen “Expressions” for stgrrelsen “bredde_skuff”
0 Name = bredde_skuff

0 Trykk “Create Interpart Reference” @
Du kommer na inn i dialogboksen “Select Part” (Figur 5-11).
0 Trykk “Choose Part File”
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Du kommer na inn i dialogboksen ”Part name” (Figur 5-12).

0 Merk "fyrstikkeske_boks”
0 Trykk knappen ”OK”

Du kommer na inn i dialogboksen “Create Interpart Reference” (Figur 5-13).

0 Merk ”bredde=36"
0 Trykk knappen ”OK"

Du kommer na tilbake til dialogboksen ”Expressions”.

0 Tastinn ="-2*" (minustegnet, to tallet og gangetegnet pa tastaturet)
0 Trykk "Create Interpart Reference” @J

Du kommer na inn i dialogboksen ”Select Part” (Figur 5-14).

0 Under omradet "Choose loaded part”, merk “fyrstikkeske_boks.prt”
0 Trykk knappen ”OK”

Du kommer na til dialogboksen ”Create Interpart Reference” (Figur 5-15).

0 Merk "tykkelse=1"
0 Trykk knappen ”OK”

Du kommer na tilbake til dialogboksen ”Expressions” (Figur 5-10).

o  Trykk @
2
[ Chogue Fars File 1 it
Chasse loaded pan
iu.-. name 'S!
S TTH o s
9
— _— o
FIGUR 5-11 FIGUR 5-12
"% [Create Interpart Reference [X
r Choose Par File 1 -
: bredde=38

Choose loaded part
[tyrstikkeske_boks pro

Part name
fyrstikkeske_boks.prt k=)

FIGUR 5-14

hoyde=bredde/2
lengde=breddes1.518
pi=lengde
p7=bredde

p&=hoyde
po=tykkelse

!—M—H Back ][ Cancel

FIGUR 5-15

W[ Create Interpart Rererence %

redde=36
hoyde=bredde/2
lengde=bredde*1.618
pi=lengde
pr=bredde
p8=hoyde
pa=tykkelse
tykkelse=1

I—@@—H Back ][ Cancel

FIGUR 5-13

e Gjgr sa det samme for lengde, hgyde og tykkelse. Husk lengde skal ikke trekke fra noen tykkelse.
e  Trykk knappen “OK”

Du kommer na tilbake til arbeidsvinduet i NX.
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Blokk
e Insert > Design Feature = Block...
Du kommer inn i dialogboksen ”Block” (Figur 5-16).

e  Fyllinn i dialogboksen “Block”
0 “Type” = Origin and Edge Lengths
0 Length (XC) = lengde_skuff
0 Width (YC) = bredde_skuff
0 Height (ZC) = hoyde_skuff
e Trykk knappen ”OK”

Du kommer tilbake til arbeidsvinduet i NX (Figur 5-17).

Type A
Ig Crigin and Edge Lengths a
Origin A
.Va:ggs‘@é’ig_mmrm %:
Dimensions A
Length {XC}
Boolean | A
Preview | ¥
o) [emy ) (one )
FIGUR 5-16 FIGUR 5-17
Skall

e Insert = Offset/Scale = Shell...
Du kommer na inn i dialogboksen ”Shell” (Figur 5-18).

o Velg fra seksjonen “Type”
0 Funksjonen “Remove faces, then shel
o Fyllinniseksjonen “Thickness”, der skal du referere til det du skrev i “Expression” med tykkelse
0 "Thickness” = tykkelse_skuff
e Merk toppflaten av boksen (Figur 5-19)
e  Trykk knappen ”OK"

|ll

Og du kommer tilbake til arbeidsvinduet i NX (Figur 5-20).

| Type A

| | % Remove Faces, Then Shel

| Face to Pierce A
v seharrace ) =)
| Thickasss |

”
Thickness ey e 1:- EERREO]

Reverse Direction #
| Altemare Thickness v
| semings ¥
I Proview v L
g (el [=apowy-] [-cance '
FIGUR 5-18 FIGUR 5-19 FIGUR 5-20

e View - Operation > Fit
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e  File > Save (Ctrl+S)
e File = Close = All Parts

Montering (Assembly)

Na skal boksen og skuffen settes sammen. Da ma du lage en fil som er "Non-Master part”. Det vil si at den
henter inn eksisterende deler fra andre filer. Na skal du lage filen fyrstikkeske_assey.prt i NXkurs mappen,
og velge malen ("Templates”) "Assembly” fordi det skal veere en sammenstilling, og den skal bruke

enheten millimeter.

e  File > New... (Ctrl+N)

Du har nd kommet inn i vinduet "New” (Figur 5-21).

e Fyllinn fglgende i vinduet

0 Under omradet "New File Name” fyller du inn i “Name” = fyrstikkeske_assey.prt

0 Under omradet "New File Name” velger du i “Folder” = NXkurs

0 Under omradet "Templates” velger du ”"Assembly”

0 Under omradet "Templates” velger du i ”Units” = Millimeters

e  Trykk knappen ”OK”

Du kommer na inn i dialogboksen "Add Component” (Figur 5-22).

Fr [rswcrasie_poks

Ftypa [PanFias( pr)

FIGUR 5-21

FIGUR 5-22

FIGUR 5-23

T
e  Trykk pa knappen "Open” U som star til hgyre for “Open” i seksjonen ”Part”

Du kommer nd inn i vinduet ”Part Name” (Figur 5-23).

o  Merk filen "fyrstikkeske_boks.prt”
e  Trykk knappen ”OK”

Du kommer na tilbake til dialogboksen “Add Component”.

e Velgiseksjonen “Placement” at ”Positioning” er ”“Absolute Origin”

e Trykk knappen ”OK”
Du kommer na inn i arbeidsvinduet i NX.
e View = Operation - Fit

Legg til eksisterende del

Du har hentet inn boksen, og na skal du legge til skuffen.

e Assemblies > Components 2 Add Component

Du kommer na inn i dialogboksen "Add component” (Figur 5-24).

T
e  Trykk pa knappen "Open” U som star til hgyre for “Open” i seksjonen ”Part”

30



Du kommer nd inn i vinduet ”Part Name” (Figur 5-25).

o Merk filen "fyrstikkeske_skuff.prt”
e  Trykk knappen ”OK"

Du kommer na tilbake til dialogboksen “Add Component”.

e Velgiseksjonen “Placement” at ”Positioning” er "”By Constraints”
e Trykk knappen ”OK”

Part Name

Soki |2 Nikurs x| ~Ecm-

— W [Assembly Constraints [9T=T%
% 1) Sifyrstideske_bos gipe =

[*:] Touch Align H

fyrstikkeske_sku]
Mine sisle
Aok (@ cipiO
@ Geometry to Constrain N
Skiebord

’j  Preview

s domumerier * Select Two Objects (0)
Z2ee ﬁ Revarse Last Canstraint [
i | Min datamaskin Lo v
Piacemes - - :
Paainzaing b Cormminy | g Frevizw A
[Clscazer [mE Wind

| Mine review Window
i tikkeske_skufl » oK
enlieios 2 L Pt Sl GocEs| [)Preview Compenent in Main Window
Semings ¥ Fillype: [PartFiles (o) | Avbryt
Previem v
— ‘ [—ok—] [ 2pply ][ cancel
FIGUR 5-24 FIGUR 5-25 FIGUR 5-26

Du kommer na inn i dialogboksen ”"Assembly Constraints” (Figur 5-26). Her skal man sette betingelser til
sammenstillingen. For 3 fa skuffen til a gli i boksen, settes det at venstresiden av skuffen skal veere i
naerkontakt med venstresiden pa innsiden av skuffen. Det samme skal skje med utsiden av bunnen til
skuffen, den skal akkurat treffe innsiden av bunnen til boksen. Da settes ”Orientation” til ”Prefer Touch”.
Det er mulig & sette ”"Orientation” til at sidene skal std normalt pa hverandre eller normalretning i samme
retning. Det kan man selv velge. | omradet "Type” velger man hva slags betingelser man vil sette.

e Velg "Touch Align” i seksjonen "Type”
e Sett "Orientation” til "Prefer Touch” i seksjonen ”“Geometry to Constraint”

FIGUR 5-27 FIGUR 5-28

e Merk ytre venstre lengde/hgyde flate pa skuffen (Figur 5-27)
e Merk indre venstre lengde/hgyde flate i boksen (Figur 5-28)



Component Preview

FIGUR 5-29 FIGUR 5-30

e  Merk ytre bunnflate pa skuffen (Figur 5-29)
e  Merk indre bunnflate i boksen (Figur 5-30)
o  Trykk knappen ”OK”

Du kommer na tilbake til arbeidsvinduet i NX.
Flytt pa skuffen

Denne funksjonen er for a kunne flytte en del uavhengig av alt. Den kan settes opp til & veere avhengig av
betingelser eller ikke.

e Assemblies > Component Position = Move Component...
Du kommer nd inn i dialogboksen “Move Component” (Figur 5-31).

o  Merk skuffen i arbeidsvinduet (Figur 5-32)

o  Trykk knappen ”Position” i seksjonen ”Position”

% [ Move Companent

Components to Move | A
*Seiec‘k{:pm ponents {0} :.== E
Transform A

Copy M
Settings v L
oK Apply " 2
FIGUR 5-31 FIGUR 5-32 FIGUR 5-33

e Tatak iden den gra xc-pilen til WCS (Figur 5-34) i arbeidsvinduet, og flytt pa skuffen ved & holde
MB1 nede pa den gra pilen (Figur 5-33) i skyveretningen av skuffen, mens du beveger musen. Da
skal skuffen blir skjgvet ut av boksen
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You have unapplied changes.
! [0 you really want to cancel?
L

(IF wou choose “es', the unapplied changes will be lost,)

FIGUR 5-34 FIGUR 5-35

Na ser du at du kan flytte skuffen i xretning. | y og z retning er skuffen Iast fast i boksen ved at du har gitt
betingelsen at skuffen skal ligge inntil to flater i boksen.

e  Trykk knappen ”“Cancel” i dialogboksen "Move Component”

Du kommer na inn i varselvinduet “Move Component”. Den forteller at det har blitt gjort forandringen, og
om du er sikker pa at du vil avbryte forandringene slik at alt blir tilbakestilt slik det var fgr du gikk inn i
”"Move Component”. Dette gnsker du a bekrefte.

e  Trykk knappen ”Yes”

Du kommer na tilbake til arbeidsvinduet i NX.

" Arbeidskordinatsystem (Work Coordinate System, WCS)

WCS kan enten bli flyttet som egen enhet, eller bli flyttet sammen med delen. Det merkes i “Reposition
Component” ved a enten ha merket av ”Move Object” eller ”"Move Handles Only”.

Hvis du tar tak i pilen, flytter ZC
du WCS enten i X, Y eller Z i
retning. i‘

Hvis du tar tak i kulene,
roterer du WCS enten rundt X,

Y eller Z akse.  ’

Hvis du tar tak i den rgde ] &i-\ H%/.YC
boksen, flytter du WCS rundt. 1 (s
Husk, den vil fremdeles veere —ig_ -

2 H n 7 ‘/
Iast til det du har ”Matet”. \l’ﬁ(C

VRML Virtual Reality Modeling Language

Denne funksjonen brukes til & vise frem modeller pa nettsider. Den tar for seg modellen, og sa har man
anledning til a rotere pa den, og forstgrre den.

e File 2 Export 2 VRML...
Du kommer na inn i dialogboksen "VRML” (Figur 5-36).
e  Trykk knappen ”Specify VRML file”
Du kommer na inn i vinduet "VRML Output” (Figur 5-37).

e Velg det omradet du har lagret de andre filene dine
e  Trykk knappen ”OK"

Du kommer na tilbake til dialogboksen "VRML".
e  Trykk knappen ”OK”

Du kommer na tilbake til arbeidsvinduet i NX.
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% VRML X
st [ooen 5] emo@-

[ Specify VRML File | e

VRML File: ._eske_assey.wrl "rg"

Output Type [VRML 2.0 (Animated) m Skawvabod

Tolerance 1. 0

[ ok ]| Back || cancel | @ o 0 =
Mine Fityps [VRML s (e =l aem |

R~
FIGUR 5-36 FIGUR 5-37

Etter dette ma du laste ned en plugin for nettleseren din. Du finner en link til en plugin pa It’s Learning
Na kan du legge det inn som et bilde pa nettsiden din.
Avslutt

e  File > Save (Ctrl+S)
e File > Close = All Parts...



5,1. TRENINGSOPPGAVER

Oppgave 4

Modeller denne
sammenstillingen. Husk a lag
de tre delene hver for seg.
Skruen med sekskanthode,
kan gjgres en forenkling til et
rundt hodet. Nederste blokken
kan ha dimensjonene 50 x 70 x
25. Tips til den midtre biten, er
forst a lage en blokk, og sa
bruke skallfunksjonen, der fire
av sidene fjernes.

Oppgave 5

Modeller denne ved hjelp av
sylinder, "boss”, hull og
datumplan. M12 hullet
plasseres ved hjelp av et
datumplan som plasseres
tangentielt pa sylinderen.
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) )
6. LENKE [)

| dette kapittelet skal du lage en enkel lenke. Da skal du ta i bruk

funksjonen ”Sketch”. ”Sketch” vil si det samme som en skisse eller riss. Dette er det mest effektive
verktgyet for 3 lage gode 3Dmodeller. Etter du har laget en skisse kan du bruke omdreiningslegeme,
ekstrudering, ekstrudere langs en retningslinje, eller lage flate mellom flere skisser. Du skal prgve
ekstrudering og ekstrudering langs en retningslinje.

Na skal du lage filen lenke.prt i NXkurs mappen, og velge malen ("Templates”) “Model” fordi det skal veere
en enkel kun en enkel modell, og den skal bruke enheten millimeter.

e File > New... (Ctrl+N)
Du har nd kommet inn i vinduet “New” (Figur 6-1).

e Fyllinn fglgende i vinduet
0 Under omradet "New File Name” fyller du inn i "Name” = lenke.prt
0 Under omradet "New File Name” velger du i "Folder” = NXkurs
0 Under omradet "Templates” velger du "Model”
0 Under omradet "Templates” velger du i “Units” = Millimeters
e  Trykk knappen "OK”

e % W\ [ Create Sketch S [=[%X
- revien A Type ey
[ﬁ] On Plane E'! Z
Sketch Plane A
n 4 Select Planar Face orPlane (1)
snsne2es ; z
et W e e e 78 RRNEEED Rt S
2 Sketch Orientation v
E Sketch Origin v ..)r
A Settings v S
i
=== X
(===
FIGUR 6-1 FIGUR 6-2 FIGUR 6-3

Du kommer na inn i arbeidsvinduet i NX.
Skisse

Forst skal du lage et skisseplan, der skissen skal tegnes. Viktig @ tenke seg hvilken vei skissen skal
ekstruderes, for i hvilket plan du legger skissen. Her skal du ekstrudere i ZC-retning, dermed blir skissen
lagt i XC-YC plan.

e Insert & Sketch (S)

Du kommer na inn i dialogboksen ”Create Sketch” (Figur 6-2). Her er det mange valg for hvor skissen kan
plasseres.

e Velg "On Plane” fra seksjonen "Type”
e  Trykk pa ”XC—YC plane” (Figur 6-3)
e  Trykk knappen ”OK” eller MB2
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Iﬁ.leshSketchUﬂ/"\Oﬁ]_\lDN—f—@ 5‘?‘5(’4'\ hﬁvﬂLm;j{-Eﬁv

1 2 34 5 6 7 8 9 10 11 12’13 14 15|16‘17 18 19‘20E

VERKT@YLINJEN: ”DIRECT SKETCH”

1. ”“Sketch”, her lager du en ny skisse.
: 2. ”Finish Sketch” (CTRL + Q), her gar du ut av skisseapplikasjonen. :
3. "Profile”, lager en sammenhengende kurve med rette eller krummede linjer.
: 4. "Line”, lager en linje. :
5. "Arc”, lager en bue.
: 6. ”Circel”, lager en sirkel med utgangspunkt i senter eller langs punkter. :
i 7. "Fillet”, lager avrundete hjgrner. i
) 8. ”Chamfer”, lager en skrakant mellom to linjer. )
) 9. "Rectangle”, lager rektangler. )
i 10. ”Studio Spline”, lager en linje gjennom punkter. i
. 11. "Point”, lager et punkt i skissen. .
. 12. ”Offset Curve”, kopier linjen utenfor eller innenfor orginallinjen. .
. 13. ”Quick Trim”, fjerner linjer som er utenfor en kurve og som ender i ingenting. .
) 14. "Quick Extend”, sammenslar linjer. )
. 15. ”Make Corner”, kutter de to korteste endene av linjene, slik at det blir et hjgrne. .
) 16. "Inferred Dimensions”, malsetter skisser. )
. 17. "Constraints”, setter betingelser til skissen. .
18. ”"Make Symmetric”, lager en symmetrisk skisse over en linje.

. 19. ”Show all Constraints”, viser alle betingelsene.
20. ”“Open in Sketch Task Environment”, apner den active skissen i skisseapplikasjonen.

_—— e —_— e — e — e — e — e — e — e — e ——_ e ——_— e —— e ——_ e —— e ——_ e —— e — e —

(] LA A [QJO[+]/] ’

= VERKT@YLINJEN: "SNAP POINT" =

Denne verktgylinjen brukes til 3 referere mot eksisterende linjer. For at markgren skal trekkes mot et
punkt pa en linje, ma knappen vaere aktivert for den funksjonen. Du kan velge om markgren skal trekkes
_mot enden, midt pa, krysningslinje osv. Prgv de forskjellige knappene, og se hvor pa en linje markgren _
" trekkes mot. Dette er nyttig hvis du skal plassere et punkt p& en annen linje. Som standard er “Snap
_ point” satt til 3mm avstand. For & gjgre om pa denne verdien, kan du ga inn i Preferences > Sketch... og _

gjgre om “Snap angle”.

Lenken skal tegnes som en sammenhengende kurve. Da ma profil velges. Det er fordi profil lager en
sammenhengende kurve, der det velges om en rett eller buet linje skal lages mellom punktene.

e View > Operation = Set View to WCS eller hold MB3 nede og velg “Orient View to Sketch”

e Insert > Sketch Curve - Profile... (Z) eller trykk knappen ”"Profile” pa verktgylinjen ”Direct
Sketch”

Du kommer nd inn i dialogboksen ”Profile” (Figur 6-5).

e Velg knappen “Line” i dialogboksen ”Profile” (Figur 6-5)
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e Velg punktet XC=10 og YC=20
0 Merk i boksen for XC i dynamisk inndatacellen (Figur 6-6)
Skriv inn 10, som verdi for XC
Trykk knappen “Tab” pa tastaturet
Skriv inn 20, som verdi for YC
Trykk knappen "Tab” pa tastaturet

O o0OO0oOo

Object Type | Input Mode

A X¥| xc[10 |

FIGUR 6-4 FIGUR 6-5 FIGUR 6-6

Angitt koordinat eller dimensjon markeres med uthevet, for 8 komme tilbake brukes tabulatorknappen.
Trykker du feil, kan du bruke escapeknappen pa tastaturet. Da er det enklest 3 lage hele lenken pa nytt

o Velglengde = 80 og vinkel = 30
o  Trykk knappen ”Arc” i dialogboksen ”Profile” (Figur 6-7)
e  Fgr markgren ut av K2 (kvadrant 2) i kvadrantmarkgren (Figur 6-8)

% | Profile

Object Type | Input Mode

Sweep Angle

FIGUR 6-7 FIGUR 6-8 FIGUR 6-9
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* Kvadrantmarkgren er delt opp i fire kvadranter. Man kan velge hvilke kvadrant buen videre skal g& ut -
_ifra, for om buen skal std vinkelrett eller langs med tilstgtende linje. Fgr linjen ut ifra den kvadranten
" buen skal ga ut ifra. | figur 5.3 vil fglgende resultater bli: K1 = 270°, K2 = 0°, K3 = 90°, K4 = 180°

e Velg radius = 15 og "sweep” = 160

e  Trykk MB1, slik at buen gar nedover, for a gi den endelig posisjon (Figur 6-9)

e Velglengde =80

e  Trykk knappen “Tab” pa tastaturet, og vinkel pa linjen fra buen slik at den rette linjen blir tangent
med buen med radius 15 mm (Figur 6-10), trykk MB1 for & plassere linjen. Denne linjen skal sta
skratt ned til venstre fra buen

e  Trykk knappen ”Arc” pa dialogboksen ”Profile”

"% ' Circle

Circle Method || Input Mode

length(80 | ) XY

Angle | eE]

Diameter[[] ||

FIGUR 6-10 FIGUR 6-11 FIGUR 6-12

e Lag en bue som er tangentiell i begge ender, ved a fgre buen opp til det fgrste punktet du

begynte med (XC=10 og YC=20). Her kan det vaere en fordel a ha valgt "End point” pa ”“Snap
point” verktgylinjen, slik at markgren trekkes mot enden av den fgrste linjen du laget, nar du
beveger markgren i naerheten av den

e Trykk knappen ”“Escape” pa tastaturet for 8 komme ut av a lage linje

e Trykk knappen ”Escape” pa tastaturet en gang til for 3 komme ut av dialogboksen ”Profile”. Eller
bare trykk knappen ”Profile” pa verktgylinjen ”Sketch curve” eller Insert = Profile... (Z)

Na skal de to hullene lages til lenken. Lag en sirkel med diameter = 20 i hgyre ende av lenken. Plasseringen
ma bare vare innenfor lenkens ytterkant. Sentrere sirkelen gjgr vi siden. For a fa opp diameter verdi
istedenfor koordinat verdi, trykker du pa knappen ”Parameter mode” pa knapperaden som dukker opp
likt som figur 6-11. Husk trykk enter etter at du har tastet inn 20, da er det bare 3 plassere sirkelen

e Insert = Sketch Curve - Circle... (O)

Du kommer na inn i dialogboksen ”Circle” (Figur 6-11).

e Velg "Parameter Mode” - i dialogboksen ”Circle”

e  Skrivinn stgrrelsen 20 i den dynamiske inndatacellen for diameter
e  Trykk "Enter” pa tastaturet
e Plasser sirkelen ved & trykke MB1 p3a innsiden av den lille yttersirkelen (Figur 6-12)
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Lag den stg@rste sirkelen til lenken, pass pa at du fremdelen har dialogboksen ”Circle” open.

e  Skrivinn stgrrelsen 30 i den dynamiske inndatacellen for diameter
e  Trykk "Enter” pa tastaturet
e Plasser sirkelen ved & trykke MB1 pa innsiden av den stgrste yttersirkelen

e Trykk pa knappen "Escape” pa tastaturet for 8 komme ut av ”Parameter Mode”

e  Trykk pa knappen "Escape” pa tastaturet for 3 komme ut av dialogboksen “Circle”

Quick Extend

= Hvis ytterkurven ikke er sluttet (Figur 6-13), bruk “Edit = Quick Extend” eller knappen ”"Quick Extend”
(Figur 6-14) pa verktgylinjen “Sketch Curve” og trekk en buet strek over de gjeldende linjer som skal

sluttes (Figur 6-15).

FAREANY i

Quick Extend

selected boundary.

Extends a curve to another nearby curve orto a

e  File = Finish Sketch (Ctrl+Q)

Du kommer na tilbake til modelleringsvinduet i NX.

Ekstrudering

FIGUR 6-15

Na skal du ekstrudere lenken vinkelrett i begge retninger ut av skissen.

e Insert - Design Feature = Extrude (X)

Du kommer na inn i dialogboksen “Extrude” (Figur 6-16).

| Extrude S9=1%
section A
W Select Curve () [
Direction A
o Specify vector(l) [.,t_]r f_.ja
Reverse Disctian F3
Limit A
Saan value
Distane, 20 mn
End fae T
Distance 20 e
boalean A
Baolean (Nanet & fered [vl
Select Bady 10 -.-'Ij
Draft v
Offsen v
settings v
Freview v

[Feoka] [ aochy | [ Cancel |

[ No Selection Filter

Select section geometry

kv ]~ @ &% ™, [Feature Curves v]

Single Curve
Connected Curves

FIGUR 6-16

FIGUR 6-17

Tangent Curves
Face Edges
Sheet Edges

|::> Feature Curves

Infer Curves

e Velg valg av kurveregel i rullgardinmenyen pa oppgavelinjen, som bgr veere “Feature Curve”
(Figur 6-17). "Feature Curve” gjgr at alt som tilhgrer en bestem utfgrelse. Her vil alle skisser
tilhgrende skissen bli valgt, ved at en av linjene til den skissen blir markert.

e  Marker skissen
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* Hvis du far en feilmelding (Figur 6-18 eller Figur 6-19) nar du skal ekstrudere, s& kommer det at linjen er -

sluttet, men i tillegg er det en linje som stikker ut (Figur 6-20). Den kan fjerns ved a gjgre:

e Gainni”Sketch”:

Dobbelklikk pa skissen eller Edit = Sketch eller Insert = Sketch (her ma du huske & velge den
skissen du laget lenken i, ved & velge riktig skisse i ”Sketch name” pa verktgylinjen ”Sketcher”.
Edit = Sketch Curve = Quick Trim... (T)

Trykk pa linjen som stikker ut, forstgrr gjerne omradet.

File = Finish Sketch (Ctrl+Q)

FIGUR 6-20

Velg "Start” = ”Value” under seksjonen "Limits” i dialogboksen ”Extrude”

Gi stgrrelsen “Distance” = ”-20” mm under seksjonen ”Limits” i dialogboksen "Extrude”
Velg "End” = "Value” under seksjonen ”Limits” i dialogboksen ”Extrude”

Gi st@rrelsen “Distance” = “20” mm under seksjonen ”Limits” i dialogboksen “Extrude”
Trykk knappen ”OK”

Du kommer na tilbake til arbeidsvinduet i NX.

e  Trykk knappen “Isometric” pa verktgylinjen “View” (HOME)
Kantbgyning (Edge blend)
N3 skal du lage en rund ytterkant pa lenken.

e Insert - Detail Feature - Edge Blend...

Du kommer nd inn i dialogboksen “"Edge Blend” (Figur 6-21).

W[Edge Blenda |9 |X
Edge to Blend | A
r=
o selectEdge (12) &3
Add New Set @
List M
Variable Radius Points V.
Corner Sethack v
Stop Short of Corner M.
Trimming | v
Overflow Resolutions | v
Settings b,
Preview Y.
[ <ok= [ apply |[ cancel )
]
FIGUR 6-21 FIGUR 6-22 FIGUR 6-23

e Set”Radius 1” =”2.5” mm i seksjonen "Edge to Blend” i dialogboksen “Edge Blend”
e Marker kanten pa begge sider av lenken, og kanten pa begge sider av de to hullene
o Trykk knappen ”OK”

Du kommer na tilbake til arbeidsvinduet i NX. Det kan veere at du far mange feilmeldinger pa denne
kantbgyningen, det er fordi hullene av lenken star for naer kanten, slik at kantene gar inn i hverandre.
Dette lpses ved at hullene plasseres lenger inn pa lenken, bort fra kantene.
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Sentrere hull

Hullene ble ikke satt helt i senter av ytterkurvene. NX har en funksjon som heter ”"Constraints”. Det
beskriver geometriens form, og er betingelsene som settes til delen. Om delen har parallell, rettvinklet,
sentrisk og lignende linjer. Na skal du sette hullene i senter av ytterkurvene. Dette gjgres i “Sketch”.

e  Edit > Sketch
Du kommer na inn i ”"Sketch”.

e Insert & Sketch Constraints = Constraints... (C)
e Merk den ene sirkelen, og sa tilhgrende ytterkurve (Figur 6-22)

Du kommer na inn i dialogboksen ”Constraints”.

e Velg knappen sentrisk i dialogboksen ”Constraints”
e Sett den andre sirkelen ogsa i senter, ved a gjgre det samme

"% Constraints

Constraints

v @6 -

FIGUR 6-24

e  File = Finish Sketch (Ctrl+Q)

Du kommer na inn i modelleringsvinduet i NX

Hvis du velger
zplan.

"Fix” nar du lager betingelser, betyr det at delen / linjen / punktet vil bli 13st i x, y, og .

Forandre geometri

Noen ganger gjgr man forandringer pa en figur. Det skjer at det skal inn et skar, eller glemt en radius. Na
skal vi fierne den nedre rette linjen, og legge til en buet linje. For 3 komme inn i skissen, kan du enten
dobbeltklikke pa skissen, eller bruke “Edit = Sketch”. Hvis du velger & lage en ny skisse, sa vil det bli et
helt nytt plan som lages, der du kan lage punkter fra eksisterende linjer, men ikke gjgre om linjer i andre
skisser.

e Edit = Sketch
Du kommer na inn i “Sketch”.

e View = Orient View to Sketch (Shift + F8)
e Insert & Sketch Curve = Arc (A)

Du kommer na inn i dialogboksen “Arc” (Figur 6-25).
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Arc Method

[ ™

Input Mode

FIGUR 6-25

Arc by 3 Points

FIGUR 6-26

e Velg knappen ”Arc by 3 Points”

e Velg punkt 1 pa Figur 6-26
e Velg punkt 2 pa Figur 6-26

e  Gistgrrelsen "Radius” = 80 i den dynamiske inndatacellen.
o  Trykk knappen “Enter” pa tastaturet
e Trykk MB1 inne i figuren, slik at buen blir plassert inne i lenken (uplassert bue er oransje)

Du vil na fa opp en informasjonsboks som sier at modellen din har en feil. Dette kan rettes opp ved &
slette den ekstra linjen.

e  Trykk MB2 eller "Escape” for a fjerne markgren for bue
e Merk linje 1i Figur 6-27, og trykk pa "Delete” knappen pa tastaturet.

J .

(,

FIGUR 6-27

L

e Insert = Sketch Constraints = Constraints (C)
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FIGUR 6-28

e Merk bue 1 (Figur 6-28) og merk bue 2
Du kommer na inn i dialogboksen ”Constraints”.
e Velgtangent @
e Merk bue 2 (Figur 6-28) og merk bue 3
Du kommer na inn i dialogboksen ”Constraints”.
e Velgtangent @
e  File = Finish Sketch (Ctrl+Q)
Du kommer na tilbake til modelleringsvinduet i NX.
e Velg "Isometric” pa verktgylinjen "View” (HOME)
Avlisutt

e File 2 Save
e File 2 Close = Selected Parts...

Du kommer na inn i dialogboksen ”Close Part”.

e  Merk lenke.prt
e  Trykk knappen ”OK”
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6,1. TRENINGSOPPGAVER

Oppgave 6

Modeller denne. Lag to skisser
som er perpendikulzaere. Lurt a
bruke trimfunksjonen.

Oppgave 7
Modeller denne ved hjelp av
skisse og speiling.

45



7. VINKELF@RING

Kapittel syv skal ga igjennom datumplan.
Datumplan brukes for a lage skisser pa, speile
eller referere med. | denne oppgaven skal det
lages en vinkelfgring. Den bestar et vinkelstal,
som det skal lages et skar i, og fire hull.

e File 2 New... (Ctrl+N)
Du har nd kommet inn i vinduet "New” (Figur 7-1).

e Fyllinn fglgende i vinduet
O Under omradet "New File Name” fyller du inn i “Name” = vinkelforing.prt
0 Under omradet "New File Name” velger du i “Folder” = NXkurs
0 Under omradet "Templates” velger du “Model”
0 Under omradet "Templates” velger du i ”Units” = Millimeters
e  Trykk knappen "OK”

9] Simulatan] wanufactunna|[insoecuan | Mechar

Concastoenaner]

I e
st adiled 04/13/2010 1243 1
Descignon NN Example wichcaeur C5¥S b3

Uity

FIGUR 7-1 FIGUR 7-2

Her skal det lages en vinkel, fgrst skissere en vinkel, som sa skal ekstruderes opp og gi enn offset. Hvis
man ekstruderer en linje, vil den veere uendelig tynn, dermed gir man den en offset som gir
ekstruderingen en tykkelse.

e Insert & Sketch (S)
Du kommer na inn i dialogboksen ”Sketch”, og et eksisterende plan er forhandsvalgt.

e Velg ZC—YC plani arbeidsvinduet pa WCS (Figur 7-2)
o Trykk knappen ”OK"”

Du kommer na inn i ”"Sketch”

View = Orient View to Sketch (Shift + F8)

Insert = Sketch Curve - Profile (2)

Velg “Line” i seksjonen ”Object Type” i dialogboksen ”Profile”
Fyllinn i den dynamiske inndatacellen

0o XC=75

0 Trykk knappen ”Enter” pa tastaturet
o YC=0

0 Trykk knappen ”Enter pa tastaturet

e  Trykk "Coordinate mode” @i seksjonen ”Input Mode” i dialogboksen ”Profile”
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NX vil fgrst at du oppgir en koordinat, og sa gi linjen dimensjoner og retning. Ved a velge "Coordinate
mode” kan du forsette a oppgi koordinater.

e Fyllinn fglgende parametere i den dynamiske inndatacellen
O XC=0o0gYC=0
O XC=0o0gYC=75
e  Trykk knappen ”“Escape” for a komme ut av dynamisk inndatacellen
e  File = Sketch Finish (Ctrl+Q), du kommer na tilbake til modelleringsvinduet

Vinkelen skal ekstruderes XC retning, og sa skal den fa en tykkelse. Pass pa at ekstruderingen skjer i positiv
Z og Y retning, altsa inn i vinkelgapet

e Insert - Design Feature = Extrude (X)

Du kommer na inn i dialogboksen ”Extrude” (Figur 7-3).

W [ Extrude ’_’_’—
Section
 Select Curve (2) F._é] W

Direction A End ’ 0

« Specify Vector {1} [:I] [E Star=28
Rewverse Direction ,\‘I

Limits A

Start Vi A

Distance
End

Distance

Boolean A
Boolean (None) 1@ Inferred [V]
Select Body (0) Uj

Draft Y
Offset M
Offset 1Twu-5|ded Ev}
Start [u] mm

End -8 mm

Settings v
Preview v

[k [ annly | [ Gancel )

FIGUR 7-3 FIGUR 7-4

e Merk skissen
e  Givinkelen ekstruderingsgrenser fra 0 til 120 mm i positiv x retning i seksjonen ”Limits”
0 ”“Start” ="Value”
0 ”“Distance” =”0" mm
0 "End” ="Value”
0 “Distance” = “120” mm
e  Givinkelen tykkelse fra -8 til 0 mm i seksjonen ”Offsets”

0 "Offset” = “Two-sided”
0 ”Start” =“0” mm F\\
o llEndM - "8" mm %

o  Trykk knappen ”OK”
Du kommer na tilbake til arbeidsvinduet i NX. [

Na skal du lage fgringskaret. Den skal settes inn i godset pa S
yttersiden av vinkelen. Er du usikker pa hvordan den skal se ut, se pa '

figur ved kapitteloverskriften. Du skal bruke en “Boolean” funksjon som heter ”“Subtract”. Den fjerner
godset istedenfor a legge pa som man gjgr med "Ekstruder”.
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e Insert = Sketch... (S)

Du kommer na inn i dialogboksen ”Create Sketch”.

C
FIGUR 7-5 FIGUR 7-6

e Velg ZC—YC plan i WCS (Figur 7-5)
e  Trykk knappen ”OK” i dialogboksen “Create Sketch”

Du kommer na inn i ”Sketch”.
e Insert - Sketch Curve - Rectangle (R)
Du kommer na inn i dialogboksen ”"Rectangle”.

e  Girektangelet plassering og dimensjonene i den dynamiske inndatacellen

0O XC=0o0gYC=54

0 Width =4 og Hight=9.6
o Trykk MB1 for a feste rektangelet, viktig a legge rektangelet inn i godset og ikke utenpa
e  File = Finish Sketch (Ctrl+Q)

Du kommer na tilbake til modelleringsvinduet i NX.

o Velg “Left” pa verktgylinjen “View” (Ctrl+Alt+L) (Figur 7-7)
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 'Extrude o "X
section -~
« select Curve (4) [T-ﬁ
Direction ~
 Specity Vector (1) [»._,I]Ii»’-g
Rewverse Direction [#
Limits A
o —
Distance a mm
End Through All =
Boolean A
soolen )
+ select Body (1) (@
Draft A
~ [m" None = ]
e OP® [ W F. o Al
.:
efepo. g @agg ™~
i I
DL ape s e —
I’ o - : Tolerance 0.0254
| Left |
II Orients the work view to align with the |eft view (LEFT}, Brovimy, X
_-|{CtrI+AIt+L> [0k [“apply | [ Cancel
FIGUR 7-7 FIGUR 7-8 FIGUR 7-9

e Insert - Design Feature = Extrude (X)
Du kommer na inn i dialogboksen ”Extrude” (Figur 7-8).

e  Merk skissen du nettopp lagde (Figur 7-9)
e  Gifgringen ekstruderingsgrensene fra start og igjennom alt i positiv retning i seksjonen ”Limits”
O “Start” = “Value”
O “Distance” = “0” mm
0 “End” =“Through All”
e Velg a trekke fra materialet som en bolsk funksjon, da brukes skissen som et vertkgy til 3 hule ut
noe.
Boolean B Subtract =

@ Mone
J" Unite

Subtract

0 “Boolean (Unite)” = “Subtract” i seksjonen “Boolean” Praft
o  Trykk knappen “OK”

Du kommer na tilbake til modelleringsvinduet i NX.

Selection Steps = = l-‘u Plane &
L0 = | Ay - | Anew
0¥ w|aorn
= B | 5o
— LGN

| =

[7] Assucistive

@ o) (oo ) Comen ]

FIGURE-L FIGUR 6.2 FIGUR 6.3



Datumplan for hull
Na skal du lage noen datumplan for a fa referanser til hullene som skal veere i vinkelen.

e Velg "Isometric” pa verktgylinjen "View” (End)
e Roter delen slik at du ser pa baksiden (Figur 7-10)

w [Datum Plane

il Bisector

First Plane

[ + Select Planar Object {1}

Second Plane A
Plane Orientation |ov,
Offset |
Settings |v.
[===]
FIGUR 7-10 FIGUR 7-11 FIGUR 7-12

e Insert > Datum/Point = Datum Plane...
Du kommer na inn i dialogboksen "Datum Plane” vinduet (Figur 7-11)

e Velg type plan som er i midten av to valgte plan pa modellen
0 Velg” Bisector Plane” under seksjonen “Type”

e Velg de to planene datumplanet skal std midt imellom av (Figur 7-12)
0 \Velgplanl
O Velgplan2

o Trykk knappen ”OK”

Du kommer na tilbake til modelleringsvinduet

e  Gjgr sa det samme for planene plan 3 og plan 4 i Figur 7-13
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Semings v

Freview b4
Sronte] Ceance’)

FIGUR 7-13 FIGUR 7-14 FIGUR 7-15 ===

Etter at du har gjort dette skal du speile hullene om datumplanene. Fordelen na er at du bare trenger a
gjore om dimensjonene pa ett hull, og plasseringen, sa vil de andre hullene fglge etter. Fgrst ma du lage et
hull, og sa skal du speile.

Hull
e Insert = Design Feature = Hole...
Du kommer na inn i dialogboksen "Hole” (Figur 7-14).

e Velg "Hole Series” i seksjonen "Type”

e "Screw Size” ="M10”

o Velg "Specify Point” i skesjonen ”Position” i dialogboksen “Hole”

e Merk flaten hullet skal starte fra, plasseringsflaten (flate 1) (Figur 7-15)

Du kommer na inn i applikasjonen ”Sketch” og dialogboksen ”Sketch Point”.

% | Sketch Point

FIGUR 7-16 FIGUR 7-17 FIGUR 7-18

e  Marker i hver kvadrant pa flaten slik som i Figur 7-16
e  Trykk knappen ”Close” (Figur 7-17)

Du kommer nd inn i arbeidsvinduet.
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Dobbeltklikk med MB1 pa dimensjonene til punktet nederst til hgyre, og malsett den til 15 med
mer (Figur 7-18)(Figur 7-19)
Insert 2 Make Symmetric...

Du kommer na inn i dialogboksen "Make Symmetric”

Velg punkt nederst til hgyre som “Primary Object” (Punkt 1 Figur 7-20)
Velg punkt nederst til venstre som ”"Secondary Object” (Punkt 2 Figur 7-20)
Velg datumplanet i midten som ”"Symmetry Centerlinne” (Linje 3 Figur 7-20)

Gjgr sa det samme med de to siste punktene, men husk & bytte symmetrisenterlinje.

Trykk “Close” i dialogboksen “Make Symmetric”
Task = Finish Sketch (Qtrl + Q)

Du kommer na tilbake til arbeidvinduet og dialogboksen “Hole”

Velg mappen “End” i dialogboksen “Hole” i seksjonen ”Spesification”
Velg "Depth Limit” til “Through Body” (Figur 7-18)
Trykk knappen “OK”

Du kommer na tilbake til arbeidsvinduet.

[ Hale [37=T%
Type A
[t v

Fasition

o Specify Pointil) [

Dirsctian

Male Direcrize [ warm 0 race |

specification A

[ b symmenic |51 % B [L5sar | naccie] €nd

Primary Object Al Farm and Dimensiess A
* Seloct Object (0] m ‘ o [of] Mazch Dimensions of Stam Hole
secondary Object A 3

*seecihjeci A ‘ EC:

< Al
3
(o )

N
i

i

]
?

FIGUR 7-19 FIGUR 7-20 FIGUR 7-21

Avslutt

File = Close = Save and Close
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7,1. TRENINGSOPPGAVER

Oppgave 8 i
Modeller denne. 3 13 3 3

Oppgave 9
Modeller denne.
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8. MILI@KOPP

Na skal du lage SIT sin miljgkopp. Da skal du leere a bruke
omdreining og ekstrudering langs en linje.

e File 2 New... (Ctrl+N)
Du har nd kommet inn i vinduet "New”.

e Fyllinn fglgende i vinduet
0 Under omradet "New File Name” fyller du inn i "Name” = kopp.prt
0 Under omradet "New File Name” velger du i “Folder” = NXkurs
0 Under omradet "Templates” velger du “Model”
0 Under omradet "Templates” velger du i "Units” = Millimeters

e  Trykk knappen ”OK”
Du kommer na inn i arbeidsvinduet i NX.
Koppen

Na skal du fgrst lage en skisse som er yttermalene, og sa dreie dette rundt en akse. Skal i tillegg bruke
offset for a lage tykkelse pa flaten.

Skisse
Det blir en vinkel som dreies rundt en akse.
e Insert & Sketch in Task Environment...

Du kommer na inn i dialogboksen ”Create Sketch”.

py

FIGUR 8-1

e Velg ZC - XC plan i WCS i arbeidsvinduet
e  Trykk knappen ”OK” i dialogboksen ”Create Sketch”

Du kommer na inn i ”Sketch”.
@F\mshsketch SKETCH_000 [wi ‘[‘95_ ﬁ 9:1, il | o By |

" s )

W Defines the name of a sketch or activates an existing
. . =2 sketch {(by choosing it from the list).
o Giskissen navnet kopp ... ...

0  Skrivinn ”Sketch name” “kopp” i verktgylinjen ”Sketcher”
0 Trykk enter
e Insert = Curve - Profile (Z) hvis ikke dette har kommet automatisk
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e  Skrivinn i den dynamiske inndatacellen

0O XC=00gYC=0

O Lengde 32 og vinkel 0

0 Lengde 114 og vinkel 90
e  Trykk to ganger pa knappen "Escape” for 8 komme ut av dialogboksen ”Profile”
e Insert = Curve - Fillet (F)

Du kommer nd inn i dialogboksen “Create Fillet” (Figur 8-2).

—

‘% Create Fillet

Radius 3
Fillet Method || Options
_-q -...rx t24“‘
. V)
FIGUR 8-2 FIGUR 8-3

e Merk de to linjene du nettopp laget (Figur 8-3), sgrg for at du beveger markgren slik at buen
kommer inn i koppen mot z-aksen.

e  Skrivinn i den dynamiske inndatacellen ”Radius” = ”5”og trykk "Enter”

e Trykk en gang pa “Escape” for a komme ut av funksjonen ”Create Fillet”

e Task = Finish Sketch (Ctrl+Q)

Du kommer na tilbake til modelleringsvinduet i NX.
Omdreining

N3 skal du dreie skissen rundt ZC aksen, da vil du fa en kopp ut av vinkelen. | tillegg skal du bruke offset
for a gi den en tykkelse.

e Insert > Design Feature - Revolve (R)

Du kommer nd inn i dialogboksen “Revolve” (Figur 8-4).
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= [Revolve [ST=T%

Section A
 Select Curve (3)
Reverse Direction
Specify Oriain Curve [/T|
Axis A

& Specify Vector {1}
Reverse Direction

Specify Point (0]

> |

Limits

Start
Angle
End

Angle

*] 4«5

3
g
]

Boolean

>

Boolean

3
g
>

End

Settings

Preview

g
il | T
b =
o | - S
<< HE®

FIGUR 8-4 FIGUR 8-5

e  Merk skissen “KOPP” i arbeidsvinduet
Roter skissen rundt Z-aksen
0 Trykk pa “Specify Vector (0)” under seksjonen “Axis
Merk Z-aksen i arbeidsvinduet
”Start” = "Value” under seksjonen “Limits”
“Angle” ="”0” under seksjonen “Limits”
"End” = "Value” under seksjonen “Limits”
0 “Angle” ="360" under seksjonen “Limits”
Gi modellen et skall (Figur 8-5)
"Offset” = “Two-Sided” under seksjonen “Offset”
0 "Start” = “-3” under seksjonen “Offset”
0 ”"End” = “0” under seksjonen “Offset”
Trykk knappen “OK”

”

.
O o0OO0oOo

Du kommer tilbake til arbeidsvinduet i NX.
Hank

Her skal du lage hanken til koppen. Da lager du fgrst en tverrlinje pa innsiden av koppveggen, som skal
folge en fgringslinje. Husk, skissen til koppen ligger pa utsiden av koppveggen, og offset har laget
ekstruderingen innover mot aksen.

Skisse
Na skal du lage en tverrlinje som skal fgres langs en linje. Til sammen blir dette hanken.
e Insert - Sketch in Task Environment...

Du kommer na inn i dialogboksen ”Create Sketch”.

56



W [Create Sketch

Type

| Y} On Plane

Sketch Flane

M
v
| A

" Specify Plane

Sketch Orientation | A

;ﬁ
B OO ETEREZN A

B B
Reverse Direction
Sketch Origin |w
Settings . hf
=
FIGUR 8-6 FIGUR8-7 FIGUR 8-8

e Sett ”Plane Method” til “Create Plane” i seksjonen ”“Sketch Plane”

|
e Velg XC - ZC plan fra rullgardinen (Figur 8-7) til "Specify Plane” under seksjonen ”Sketch
Plane”
e Trykk pa den rosa pilen midt i datumplanet i arbeidsvinduet, til du far pilene til & sta i den
retningen vist i Figur 8-8
e Velg "Select Reference (0)” og marker X til horisontalreferansen
o  Trykk knappen ”OK”
e  Giskissen navnet hank_ref
0 ”Sketch name” = hank_ref i verktgylinjen ”Sketcher”
o  Trykk ”Isometric” pa verktgylinjen ”"View” (END)
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Tverrlinjen skal ga pa tvers, og da brukes innerflaten av koppen som en referanse. Det er fordi hvis
tverrlinjen hadde gatt fra ytterkanten av koppen, sa ville hanken kun vaert tangent pa flaten og ikke
igiennom koppgodset. Etterpa skal den delen av hanken som gar inn i godset trimmes bort.

e Insert = Curve - Profile (Z), hvis denne funksjonen ikke allerede er pa

Du kommer na inn i dialogboksen “Profile”.

BREERR R E

s and drag to begin arg creation

Quadrant Point
Allows quadrant points of arcs and ellipses to be
selected.

FIGUR 8-9 FIGUR 8-10 FIGUR 8-11

e  Gjgr “Snap point” “Quadrant Point” aktiv (Figur 8-9)

e Velginnerkanten av koppen, altsa 3mm innenfor skissen fra koppen (Figur 8-10)

e Lag en parallell linje langs koppen (ca 60 mm), den er kun for 3 lage en referanse linje for
tverrlinjen, sa lengde ma vaere minst fra toppen av koppen til ca midt pa kopphgyden. (Figur
8-11)

e  Trykk to ganger pa "Escape” for 3 komme ut av dialogboksen ”Profile”.

e Tools & Constraints = Convert To/From Constraints...

Du kommer na inn i dialogboksen “Convert to/from reference” (Figur 8-12).

® [Convert To/From Reference 2 — X

Object to Convert A

+ Select Object (1)

[ select Projected Curve

Convert To A

(® Reference
() Active

[—ok—]| Apply || cancel |
R —————————————,
FIGUR 8-12 FIGUR 8-13 FIGUR 8-14

e  Merk linjen du nettopp laget (Figur 8-13)
e  Trykk knappen “OK”

Du kommer na tilbake til arbeidsvinduet i NX.
e  Task = Sketch Finish (Ctrl+Q)

Du kommer na tilbake til modelleringsvinduet i NX. Koppgodset skal flyttes til et annet lag, slik at det blir
lettere 3 se skissene.

e Format - Move To Layer...
Du kommer na inn i dialogboksen ”Class Selection”.

e  Merk koppen ”Solid Body”
e  Trykk knappen ”OK"

Du kommer na inn i dialogboksen ”Layer Move”

e Skriv”2” inni ”"Destination Layer or Category”
e Trykk knappen “OK”
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Du kommer tilbake til arbeidsvinduet i NX.
e Format = Layer Settings... (CTRL + L)
Du kommer na inn i dialogboksen ”Layer Settings”.

e  Merk layer ”2” i ”Solids” i lagtreet under seksjonen ”Layers”
e Utvid omradet “Layer Control” i seksjonen ”Layers” ved a trykke pa nedoverpilen vedsiden av
”Layer Control”
e  Trykk knappen ” Make Invisible”
e  Trykk knappen ”Close”
Datumplan

Na skal du lage et datumplan ved referanselinjen, dette for & fa et plan som du kan lage tverrlinjen pa.
e Insert & Datum/Point = Datum Plane...

Du kommer na inn i dialogboksen “Datum Plane”.

® [Reattach Sketch [a=]% Ly

Type A

Sketch Plane A .I

Plane Method ]Exlstmg Plane E 3

4" Select Planar Face or Plane (1)

4

Reverse Direction

Siealea

Sketch Orientation

Reference Harizonral
4" Select Reference (1}
Rewerse Direction

Sketch Origin

P

<L:]>@ﬂ

4" Specify Point {1} @ j}_ |
Settings T‘i 1
e =
(Ceeneel]) \H%
e
J
FIGUR 8-15 FIGUR 8-16

e Velg "Point and Direction” i seksjonen "Type” i dialogvinduet "Datum Plane”

e  Pass pa at "End Point” pa verktgylinjen er aktivert

e Merk gverst pa referanselinjen HANK_REF

e Velg "XC axis” i rullgardinen til “Specify Vector (1)” i seksjonen "Normal Direction” i dialogvinduet
"Datum Plane”. (Figur 8-15)

e  Trykk knappen “OK”

Du kommer na tilbake til arbeidsvinduet i NX

Skisse

Tverrlinjen skal lages. Den skal som sagt fgres langs en fgringslinje etterpa. Hvis du tenker deg en strek i
vinkel som er tegnet pa tavlen er fgringslinjen. Sa vil krittet du holder i handen med langsiden mot tavlen,
veaere tverrlinjen. Nar du fgrer sa krittet langs fgringslinjen slik at det blir en tykk strek, sa vil det bli til
sammen bli en hank.

e Insert = Sketch in Task Environment...
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Du kommer na inn i dialogboksen ”Create Sketch”.

e Velg det nye datumplanet
e Trykk pa Y-aksen som star i WCS for a definere horisontalretningen (Figur 8-16)

e Velg "Specify Point” i seksjonen ”Sketch Origin”, og velg startpunktet i toppen av skissen
HANK_REF

e  Trykk knappen ”OK” i dialogboksen ”Create Sketch”
Du kommer na inn i ”Sketch”.

e  Giskissen navnet hank_tv

0 ”Sketch name” = hank_tv i verktgylinjen “Sketcher”
e Trykk "Isometric” pa verktgylinjen ”"View” (END)
e Insert = Curve = Profile... (), hvis denne funksjonen ikke allereie er aktivert
e Laglinjen med parametre i den dynamiske inndatacellen

0 XC=-90gYC=-9

0 Lengde =18 ogvinkel=0
e Trykk to ganger pa knappen “Escape” for 8 komme ut av dialogboksen ”Profile”
e Task = Finish Sketch (Ctrl+Q)

Du kommer na tilbake til modelleringsvinduet. Fgringslinjen ("Guideline”) vil bli den linjen som tverrlinjen
folger

e Insert & Sketch in Task Environment

Du kommer na inn i dialogboksen ”Create Sketch”.

Distance{ﬂ mm @J

FIGUR 8-17

e Velg ZC—XC plan i WCS i arbeidsvinduet (Figur 8-17)
e  Trykk knappen ”OK"

Du kommer na inn i ”"Sketch”.

e  Giskissen navnet hank_gl
0 ”Sketch name” = hank_gl i verktgylinjen ”Sketcher”
e Insert & Curve = Profile... (), hvis denne funksjonen ikke allerede er aktivert

Du kommer na inn i dialogboksen ”Profile”.
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BRI EE

s and drag to in arc creation &

. ] Input Mode
Intersection o
Allows a (projected) intersection point between XC !

two curves to be selected. YC

FIGUR 8-18 FIGUR 8-19 FIGUR 8-20

o Trykk knappen ”Isometric” pa vertkgylinjen ”"View” eller trykk knappen "End” pa tastaturet.
Dette for & se tverrlinjen til hanken bedre
e  Aktiver "Intersection Point” pd ”“Snap point” verktgylinjen, for at markgren skal trekkes mot
krysningspunktet av HANK_TV og KOPP_REF (Figur 8-18)
e  Merk av punktet der skissen til HANK_TV er (Figur 8-19)
e  Fyllinn parametrene for linjen i den dynamiske inndatacellen
O Lengde =34 o0gvinkel=0
e  Trykk knappen ”"Arc” i seksjonen “Object Type” i dialogboksen "Profile” (Figur 8-20)
e Velg nederste sektor i kvadrantmarkgren for retning av bue (Figur 8-21)
e  Fyllinn parametrene i den dynamiske inndatacellen
O Radius =150 og "Sweep” =30
o  Trykk MB1 for 3@ markere den, hanken skal ga innover mot koppen (Figur 8-22)
e Task = Finish Sketch (Ctrl+Q)

Du kommer na tilbake til modelleringsvinduet i NX.

=3

FIGUR 8-21 FIGUR 8-22 FIGUR 8-23
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: Ekstrudering langs en linje

tverrlinjer, og se hvordan resultatene blir.)

"Sweep Along Guide” er en funksjon som fgrer sirkler og lignende langs en fgringslinje. Hanken far en
offset, slik at den blir tykk. (Det hadde vaert fullt mulig a bruke ekstrudering og offset ogsa, men da hadde
ikke funksjonen blitt presentert. Ta gjerne som en egen gvelse a lag morsomme fgringslinjer og

e Insert 2 Sweep = Sweep Along Guide...

Du kommer nd inn i dialogboksen ”Sweep along Guide” (Figur 8-25), kommandolinjen sier du skal velge en
linje/streng som skal bli brukt langs en fgringslinje.

e Merk skissen HANK_TV (Figur 8-23)

e  Gatil "Select Curve (0)” i seksjonen "Guide” i dialogvinduet "Sweep Along Guide” eller MB2

"\ [Sweep Along Guide IFFE
Section M
4 Select Curve {1} m
i Guide A
3 ~
i 4 W Select Curve {1) s
L P
i Offsets A
? First Offset u] mm
Second Offset B mm ¥
i Boolean M
i Settings v
: Preview v
Ok ] [ Apply ] [ Cancel ]
1
2 TSSSSSSS———
FIGUR 8-24 FIGUR 8-25

e  Merk skissen HANK_GL, pass pa & merke begge linjene som tilhgrer denne skissen (Figur 8-24)

e  Fyllinn parametrene i seksjonen ”Offsets”
0 "First Offset” =”0” mm
0 ”Second Offset” =”6” mm

e  Trykk knappen ”OK”

Du kommer na tilbake til arbeidsvinduet i NX.

" Bolske funksjoner

med en annen "Unite” og lignende.

Ferdigstilling av hank

N3 skal du lage avrundete kanter pa hanken, lage en skrakant nederst og sa trimme hanken mot

overflaten.

= "Boolean Operation” betyr at du kan lage deler som en egen del "Create”, sammensld den

e Insert & Detailed Feature - Chamfer...

Du kommer na inn i dialogboksen “Chamfer” (Figur 8-26).
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Edge A
+ select Edge (4)
Offsets A
Cross Section
Distance mm
“Settings X
Preview b4
|~—9K=—l [ Apply ] [ Cancel ]

e ——————————————————————————

FIGUR 8-26

e Merk flaten i bunn av hanken i arbeidsvinduet (Figur 8-27)

e Sett “Cross Section” = ”Symetric” i seksjonen "Offsets” i dialogboksen ”Chamfer”

e  Giden parameteren "Distance”

o Trykk knappen ”OK”

Du kommer na tilbake til arbeidsvinduet i NX

e Insert - Detailed Feature - Edge Blend...

Du kommer na inn i dialogboksen “Edge Blend” (Figur 8-28).

% Edge Blend o = w
Edge to Blend |

o Select Edge (2) B
LEE |& an

Add Mew Se1

| st v
._\c'an.mln Radius Points Al
Specify New Location (0) = )f a

| uist v
Cormer Setback v
Stop Short of Corner v
Trim Options v
Overflow Resolutions v
Sottings |

| Overlapping Blends within Feature v
[ Bend All Instances.

[ Special Blend ar Comvex/Concave ¥

& Remove Selfintersections

Comersetback  [seporare from Conl) No Selection Filter Bl-e @

Tolerance [o.0254] Select edges for new set
'g Preview Show m«rﬁ | -
] E
FIGUR 8-28 FIGUR 8-29

% |Face Edges -
Single Curve

Connected Curves
Tangent Curves

Face Edges

Body Edges

Vertex Edges

Vertex Tangent Edges

e  Sett kurveregelen til “Singel Curve” (Figur 8-29)
e Merk begge tverrgdende kantene i arbeidsvinduet (Figur 8-30)
e Sett “Radius 1” =”6” mm i seksjonen “Edge to Blend” i dialogboksen “Edge Blend”

o  Trykk knappen ”Apply”

”3” mm i seksjonen ”Offsets”

FIGUR 8-30

Radius 1|6 mm m|




~ Cdge Blend EliE]
Edge to Blend A
' Select Edge (23) [cal
Radius 1 1 =m
Add Mew Set m

List v

variable Radius Points A
Specify New Location (0) A # g
| List v

 Comer Satback
5top Shor of Corner
Trim Options
Overflow Resolutions

> €< |<|<

sertings

| Overlapping Blends within Feature
] Blend All Instances

(] Special Blend at Convex/Concave Y a
) Remove Self-ntersections No Selection Filter B~ » @ % % [Face Edges v
Camer Sethack [separate from Corlm) | Select edges to add to current set, or ME2 t Sngle Curve

= Connected Curves
Tokerance [_o.0254 Tangent Curves
Preview Face Edges

Body Edges
Vertex Edges
Vertex Tangent Edges

FIGUR 8-31 FIGUR 8-32 FIGUR 8-33

e  Sett kurveregelen til “Face Edges” (Figur 8-32)

e  Merk flatene som vist i figur (Figur 8-33)

e Sett “Radius 1” =”1” mm i seksjonen “Edge to Blend” i dialogboksen “Edge Blend”
o  Trykk knappen ”OK”

Du kommer na tilbake til arbeidsvinduet i NX.

Na skal du trimme hanken mot flaten av koppen. Det vil si d fjerne godset av hanken som er innenfor
koppen, slik at hanken far en endeflate mot koppen som har lik form som koppen.

e  Format > Layer Settings... (Ctrl+L)
Du kommer na inn i dialogboksen ”Layer Settings”.

e Merk”2” i omradet ”Layer/Status”
e  Trykk knappen ”“Make Selectable”
e  Trykk knappen ”Close”

Su kommer na tilbake til arbeidsvinduet i NX.
e Insert 2 Trim > Trim Body...

Du kommer nd inn i dialogboksen “Trim Body” (Figur 8-34).
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® 'Trim Body R

Target A
" Select Body (1)
Tool A
Tool Option Face or Plane
 Select Face or Plane (7) [
Reverse Direction
Preview v

[~ok—|| Apply || Cancel |

FIGUR 8-34 FIGUR 8-35

e Merk hanken som er “Target Body” som skal trimmes
o  Trykk MB2 for 3 komme til “Select Face or Plane (0)” i seksjon "Tool” eller marker den
e Merk koppen som er “Tool” som skal trimme bort deler av hanken

e Trykk knappen ”“Revers Direction” ) under seksjonen "Tool” for at den grgnne pilen peker

innover. Den skal peke innover, for det er fra koppens utside og innover av hanken som skal
trimmes (Figur 8-35)
o  Trykk knappen ”OK”

Du kommer na tilbake til arbeidsvinduet i NX

e lLagen avrundet kant av innerkanten pa toppen av kanten. Gi den radius = 5
e Flytt hanken til lag 3. Gjgr sa kun lag 2 og 3 klikkbare.

Ng skal du gi hanken og koppen farge.
e Edit > Object Display... (Ctrl+J)
Du kommer nd inn i dialogboksen “Class Selection”.

e  Merk hanken
o Trykk knappen ”OK”

Du kommer na inn i dialogboksen ”Edit Object Display” (Figur 8-36).
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~ Edit Object Display
[ General | Analysis|
Basic A
Layer [ 21
2 ]
uine Font —
Width —E
Shaded Display A
Translucency
o
4
o 100
(] Partially Shaded
1] Face Analysis
‘Wireframe Display ¥
Facet Body ¥
settings v/
[ iohert !
[ Re-highlight Objects |
[ select New Objects |
[ok—][ Apply |[ Cancel
FIGUR 8-36 FIGUR 8-37

e Velg “Color” = Svart i seksjonen ”Basic”
e  Trykk knappen “OK”

Du kommer na tilbake til arbeidsvinduet i NX.
e Edit > Object Display... (Ctrl+J)
Du kommer na inn i dialogboksen “Class Selection”.

e Merk koppen
e  Trykk knappen ”OK”

Du kommer na inn i dialogboksen ”Edit Object Display”.

e Velg “Color” = Lysegra i seksjonen ”Basic”
e  Trykk knappen “OK”

Du kommer na tilbake til arbeidsvinduet i NX.
o Trykk “Isometric” pa verktgylinjen “View” (END)
Avslutt
File > Save (Ctrl+S)
File = Close = All Parts...
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8,1. TRENINGSOPPGAVER

Oppgave 10

Modeller denne. Du kan
gi muggen en tykkelse
1mm, og hanken kan
lages med fri fantasi, men
den bgr ligne tegningen.

Oppgave 11
Modeller denne.
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9. RING MED KILESPOR

| dette kapittelet skal du lage en ring med kilespor.
Den er ngyaktig lik g¢ving 18b som du har laget
tidligere. Denne skal du lage en maskintegning av
etterpa.

e  File 2 New... (Ctrl+N)
Du har na kommet inn i vinduet “New”.

e Fyllinn fglgende i vinduet
0 Under omradet "New File Name” fyller du inn i ”"Name” = oving_18b.prt
0 Under omradet "New File Name” velger du i “Folder” = NXkurs
0 Under omradet "Templates” velger du "Model”
0 Under omradet "Templates” velger du i "Units” = Millimeters
e  Trykk knappen ”OK”"

Du kommer na inn i arbeidsvinduet i NX.
Skisse

Na skal du lage en ring med kilespor. Fgrst lager du to sirkler med sentrum i origo. Sa fgrers det opp noen
referanselinjer, slik at du kan far satt kilesporet i 45 grader.

e Insert = Sketch in Task Environment...
Du kommer na inn i dialogboksen ”Create Sketch”.

e Merk XC—YCplan i WCS i arbeidsvinduet
e  Trykk knappen ”OK” i dialogboksen ”Create Sketch”

Du kommer na inn i ”"Sketch”.

e  Giskissen navnet ring
0 "Sketch name” =ring i verktgylinjen ”Sketcher”
e Insert 2 Curve = Circle... (O)

Du kommer na inn i dialogboksen “Circle” (Figur 9-1).
% [ Circle

Circle Method || Input Mode

@ o |ped e

FIGUR 9-1 FIGUR 9-2

e Velg sirkel ved senter og diameter i seksjonen ”Circle Method”, hvis denne ikke allerede er
aktivert
e  Fyllinn parametrene i den dynamiske inndatacellen for sirkel
0O XC=0o0gYC=0
O Diameter =52

Siden du igjen skal velge senterpunkt, sa vil den fgrst lage en lignende sirkel. Det enkleste er a velge sirkel
pa nytt.

e  Trykk to ganger pa knappen "Escape”
e Insert 2 Curve = Circle... (O)
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Du kommer na inn i dialogboksen ”Circle”.

o Velg sirkel ved senter og diameter i seksjonen ”Circle Method”, hvis denne ikke allerede er
aktivert
o  Fyllinn parametrene i den dynamiske inndatacellen for sirkel
O XC=00gYC=0
O Diameter =89
e  Trykk to ganger pa knappen ”Escape” for @ komme ut av dialogboksen “Circle.

Du kommer na tilbake til arbeidsvinduet i NX.

Na skal du lage to referanselinjer, for a kunne lage kilesporet.

Referanselinje

= Referanselinjer er kun linjer som du lager i skissen, men kan ikke brukes til & modelleres med. Aktive =
linjer kan du ekstrudere men, men det kan du ikke gjgre med referanselinjer.

Fgrst skal du gjgre de to sirklene sentriske, og dimensjonene faste. Sa skal du sette opp to referanselinjer
som 45 grader i forhold til hverandre. Da er det viktig a sette fast den innerste sirkelen.

e Insert & Constraints... (C)
e Merk den indre sirkelen

Du kommer na inn i dialogboksen ”Constraints”.

il
e Velg "Fixed” _

e Merk den indre sirkelen
e  Merk den ytre sirkelen

Du kommer na inn i dialogboksen ”Constraints”.

e Velg sentrisk (Figur 9-2)
e Insert 2 Curve = Line...

Du kommer na inn i dialogboksen ”Line”.

e Velg senter av sirkelen, og trekk linjen i XC retning og trykk MB1 for & sette den fast. Tips er a
bruke ”Arc center” pa ”"Snap point” verktgylinjen, for a kunne velge senter av sirkelen lettere. Nar
markgren kommer naer sirkelen, vil markgren flyttes til senter av den sirkelen den kommer naer

e Velg senter av sirkelen, og trekk linjen 45 grader oppover mot hgyre, og trykk MB1 for 3 sette
den fast (Figur 9-3)

Length[ @] |
angle | 45
e
=
Constraints
vt e
FIGUR 9-3 FIGUR 9-4 FIGUR 9-5

e Tools = Constraints = Convert To/From Reference...

Du kommer na inn i dialogboksen “Convert To/From Reference”.
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e Merk de to rette linjene (Figur 9-4)
e  Trykk knappen ”OK"

Du kommer na tilbake til arbeidsvinduet i NX.

Den horisontale linjen fikk den geometriske formen horisontal, og na skal du si at den andre linjen skal
veere konstant 45 grader.

e Insert = Constraints... (C)
e Merk linjen som er 45 grader

Du kommer na inn i dialogboksen ”Constraints”.

=
e  Trykk "Constant Angle” i dialogboksen ”Constraints”(Figur 9-5)
Kilespor

N3 skal du lage et kilespor. Da trekker du opp to linjer ut ifra referanselinjen som er 45 grader. Her er det
viktig & ha riktig “Snappoints” pa. Hvis “Arc Center” og "Quadrant Point” er p3, sa er det vanskelig a fa satt
den fast. Det er nok a bare ha ”Point on Curve”, aktiv pa verktgylinjen ”Snappoints”.

FIGUR 8.2

e Insert = Curve = Profile... (2)

Du kommer néd inn i dialogboksen ”Profile”. :

Angle | 225

FIGUR 9-6 FIGUR 9-7 FIGUR 9-8

e Lagen linje som gar 90° skratt ned til venstre fra 45° linjen. Den er vinkelrett nar dette symbolet

dukker opp
e  Giden parameteren i den dynamiske inndatacellen
0 Length="4" mm
0 Anglevil dabli 315°
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e Trykk MB1 for 4 sette den fast

e Trekk linjen sa parallelt / med 45° referanselinjen ned mot venstre. Trekk den litt innenfor
den innerste sirkelen (Figur 9-7)

e  Trykk MB1 for a sette den fast

e  Trykk to ganger escape for 3 komme ut av dialogboksen ”Profile”

Du kommer na tilbake til arbeidsvinduet i NX.

e Insert & Constraints.... (C)
e Velg de to nye linjene (Figur 9-8)

Du kommer na inn i dialogboksen ”Constraints”.

e Trykk knappen ”Perpendicular” i dialogboksen ”Constraints”, hvis denne ikke allerede er
aktivert

Du kommer na tilbake til arbeidsvinduet i NX. N& skal du speile disse to linjene om den 45°
referanselinjen.

e Insert = Curve from Curves = Mirror Curve...
Du kommer na inn i dialogboksen ”Mirror Curve” (Figur 9-9).

e Velg de to linjene du har laget (Figur 9-8), som skal speiles, slik at det blir et kilespor
e Velg speilsenterlinjen som er 45° referanselinjen
e  Trykk knappen ”OK”

Su kommer na tilbake til arbeidsvinduet i NX

"W [Mirror Curve IEFR % Quick Trim
Select Object A Baundary Curve A
4" Select Curve {2)
Select Curve (0)
Centerline .Y
Curve to Trim A
+ Select Centerline {1} E
. * Select Curve (0)
Settings Y
[ <« Ok = ] [ Lpply ] [ Cancel ]
FIGUR 9-9 FIGUR 9-10 FIGUR 9-11

Na har du fatt et kilespor. Men dette kilesporet ma bli en del av den indre sirkelen. Dermed ma du fjerne
en de linjene som er overflgdig.

e  Edit = Curve = Quick Trim... (T)
Du kommer na inn i dialogboksen ”Quick Trim” (Figur 9-10).

e Trykk pa de linjene som blir overflgdig for a lage et kilespor i arbeidsvinduet (Figur 9-11)
e  Trykk pa knappen “Close”

Du kommer na tilbake til arbeidsvinduet i NX. Kilesporet er plassert pa en linje, men den ma fa riktig
lengde, og riktig bredde.

e Insert & Dimensions = Perpendicular...

Du kommer na inn i dialogboksen ”"Dimensions”.
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e Merk toppen av kilesporet

e Merk sa senter av den indre sirkelen. Dette er litt vanskelig, for at det skal bli lettere kan du
holde markgren over origo til du far "Quick Pick” markgren. Velg sa den indre sirkelen i "Quick
Pick”. Hvorfor du velger den indre sirkelen er fordi den har fast dimensjon og er satt fast i sfeeren
ved hjel av "Fixed”.

e Giavstanden mellom origo og toppen av kilesporet dimensjonen ”"32” mm

FIGUR 9-12 FIGUR 9-13

e Insert = Dimensions = Inferred... (D)

e Velg de to sidekantene av kilesporet

e Sett dimensjonen fast ved a trykke MB1

e Giden dimensjonen 8 mm (Figur 9-13)

e Trykk to ganger pa escape for 8 komme ut av dialogboksen "Dimensions”

Du kommer na inn i arbeidsvinduet i NX.

e Task = Finish Sketch (Ctrl+Q)
Du kommer na tilbake til modelleringsvinduet i NX.
Ekstruder
Na skal du bare lage en solid figur av skissen.

e Insert = Design Feature = Extrude... (X)
Du kommer na inn i dialogboksen “Extrude”.

o Velg skissen RING
e  Fyllinniseksjonen ”Limits”
0 ”"Start” ="Value”
0 ”Distance” =”-10" mm
0 "End” ="Value”
0 "Distance” =”10” mm
e  Trykk knappen ”OK”

Du kommer na tilbake til arbeidsvinduet i NX.
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Hull

Det skal bli fire hull i ringen. Fgrst lager man ett, og sa kopierer man med 90 grader vinkel rundt en
senterakse.

e Insert - Design Feature - Hole...

Du kommer na inn i dialogboksen "Hole”.

FIGUR 9-14 FIGUR 9-15

” oo

e Velg "General Hole” i "Type”

e  Giden ”Diameter” ="”9” i dialogboksen "Hole”

e Velg "Through Body” i "Depth Limit” i seksjonen ”Form and Dimensions’
e Velg plasseringsflate (Figur 9-14)

’

Du kommer na inn i ”Sketch” og dialogboksen ”Sketch Point”.
e  Trykk "Close” i dialogboksen ”Sketch Point”
Du kommer na inn i arbeidsvinduet i “Sketch”.

e Insert = Constraints (C)
e Velg punktet og den horisontale linjen (Figur 9-15)

Dialogboksen ”Constraints” dukker opp.
e Velg "Point onto Point”
Punktet blir da lagt pa linjen.

e Insert 2 Dimensions = Inferred...(D)

e Velg punktet og senterpunktet til sirklene

e  Giden malsettingen 35 mm.

e  Trykk "escape” to ganger for 8 komme ut av ”Dimensions”

Na skal det lages fire punkter av dette punktet. For a fa til det md man ha et referansepunkt i midten. Da
lages et punkt som blir gjort om til et referansepunkt etterpa.

e Insert & Datum/Point = Point...
Du kommer na inn i dialogboksen ”Sketch Point”.

e Laget punktisenter av yttersirkelen
e Trykk “"Close” i dialogboksen ”Sketch Point”

Du kommer na tilbake til arbeidsvinduet i "Sketch”.

e Tools = Constraints = Convert To/From Reference...
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’

Du kommer na inn i dialogboksen ”Convert To/From Reference”.

e Velg punktet du lagde i midten av yttersirkelen
e  Trykk knappen ”OK”

Du kommer na tilbake til arbeidsvinduet i ”Sketch”.
e Insert = Curve from Curves = Pattern Curve...

Du kommer na inn i dialogboksen ”Pattern Curve” (Figur 9-16).

=

FIGUR 9-16 FIGUR 9-17

e  Sett ”Layout” til “Circular” i seksjonen ”Pattern Definition”

e Velg "Select Curve (0)” i seksjonen ”"Objects to Pattern” og merk punktet (punkt 1 i Figur 9-17)

e Velg "Specify Center Point (0)” i seksjonen ”Pattern Definition” og merk punktet (punkt 2 i Figur
9-17)

e Sett ”Count” til 4

e  Sett ”"Pitch Angle” til 90

e  Trykk knappen ”OK”

Du kommer tilbake til arbeidsvinduet i ”Sketch”.

e Task = Finish Sketch (Ctrl + Q)

Du kommer na tilbake til dialogboksen “Hole”.
e Trykk knappen "OK”

Du kommer na tilbake til arbeidsvinduet i NX.

Avslutt
File = Save (Ctrl+S)
File = Close = All Parts...
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10. TEGNING

Her skal du lage en maskintegning ut ifra ringen du laget i kapittel 9. Du skal ogsa sette inn tittelfelt. Nar
du lager en tegning bgr du alltid lage det som en egen fil, da far du kun modellen og ikke alle hjelpestreker
og lignende. Du lager filen ved a bruke malen for tegning. Du skal bruke en annen tegningsramme enn den
som er foreslatt i NX, derfor skal du lage en tom tegning.

e File > New... (Ctrl+N)
Du har na kommet inn i vinduet "New” (Figur 10-1).

e Fyllinn fglgende i vinduet
0 Velg mappen “Drawing”

| q—-“

0 Under omradet "Part to create drawing of” trykk pa knappen ‘

Du kommer nd inn i vinduet ”“Select Master Part” (Figur 10-2).

| q—-“

e  Trykk pa knappen "Open”

Du kommer na inn i vinduet ”Part Name” (Figur 10-3).

e  Marker filen “oving_18b.prt”
e  Trykk knappen ”OK”

Du kommer na inn i vinduet “Select master part”.
e  Trykk knappen ”OK"
Du kommer nd inn i vinduet "New”.
e Under omradet ”"New File Name” har navnet fylt seg inn automatisk til "Name” =
oving_18b_dwgl.prt
e Under omradet "New File Name” velger du i “Folder” = NXkurs
e Under omradet "Templates” velger du ”Blank”

e Under omradet "Templates” velger du i ”Units” = Millimeters
e  Trykk knappen ”OK”

.O:e'. ",: : Fie pame: [oveg_16pn
[_' | Fies ol ype [Pt ik (gt Concel
[“Cancel | |
FIGUR 10-1 FIGUR 10-2 FIGUR 10-3

Du kommer na inn i dialogboksen “"Sheet” (Figur 10-4).

e Velg under seksjonen ”Size” radioknappen ”Standard Size”

e Velg under seksjonen ”Size” stgrrelsen A3 — 297 x 420”

e Velg under seksjonen “Name” "Drawing sheet name” = ”A3 018b 01”
e Velg under seksjonen ”Settings” radioknappen ”Millimeters”
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e Velg under seksjonen ”Settings” ”Projection” fra 1. Kvadrant

e  Trykk knappen ”OK”

Du kommer na inn i arbeidsvinduet i NX.

" Insert Sheet

= Her kan du velge om du vil bruke en mal,
standardstgrrelse eller egendefinert stgrrelse pa
= arkstgrrelsen.

_ Her kan du velge standard arkstgrrelser, hvis du
har valgt standardstgrrelse.

_ Her far du listet opp de tegningene som eksisterer i
filen.

= "Drawing Sheet Name”, her gir du tegningen et
navn.

Her kan du velge mellom enhetene tomme eller

Her velger du projeksjon. Standard europeisk er
* projeksjon i fgrste kvadrant.

T

>

/ Scale 83 .
= Skalering pa modellen.

Size

M

OUse Template
@Standard Size
OCustom Size

Size !AS -207 x 420 E‘a

Name .Y

Sheets in Drawing

Drawing Sheet Name

@Millim eters
Olnches

Projection

do0/od

@Autom atically Start Base View Command

. millimeter. \ = i
Units

[ Gk 1[ Apply ][ Cancel ]

FIGUR 10-4

Du kommer na inn i "Drafting”. Siden er helt tom, og du ma sette inn tittelfelt og delen. Det er allerede

laget et tittelfelt som du kan laste ned fra it’s learning.

e Last ned tittelfelt fra it’s learning og lagre den i mappen NXkurs

Du starter med a hente inn tittelfelt med rammen. Husk pa hvor du har lastet ned tittelfeltet til.

e Format = Pattern...

Du kommer na inn i dialogboksen ”Patterns” (Figur 10-5).
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[ Update Patterns ] Scale Point Location A
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=
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FIGUR 10-5 FIGUR 10-6 FIGUR 10-7
e  Trykk pa "Retrieve Pattern”
Du kommer na inn i dialogboksen ”Retrieve Pattern” (Figur 10-6).

e  Trykk pa knappen ”OK”
e Velg "A3_mal.prt”, den du nettopp lastet ned i katalogen NXkurs
e  Trykk knappen ”OK”

Du kommer til en dialogboks der du kan navngi malen.
e  Trykk knappen ”OK”
Du kommer til dialogboksen ”Point” (Figur 10-7). Du vil sette malen i punktet (0,0,0).
e Trykk knappen ”OK”
Du vil forbli i dialogboksen ”Point”. Ikke trykk flere ganger pa “OK”, for da legger du inn flere maler.

e  Trykk knappen ”Cancel”

Du kommer na tilbake til dialogboksen ”Patterns”, du vil ikke legge inn flere rammer, dermed kanseller.

e  Trykk knappen ”Cancel”
Du returnerer til arbeidsvinduet i NX.
Sette inn ringen
N3 skal du hente inn ringen, og sette den inn i tegningen.
e Insert > View > Base ...
Du kommer na inn i dialogboksen ”Base View” (Figur 10-8).

e Trykk pa knappen "View Style” i seksjonen ”Settings”
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Du kommer na inn i dialogboksen ”View Style” (Figur 10-9).

Fracelnes | Section | Shadi | Thieads | Perpective | Base | Inhert P | ra Section | Shadmg | Threads | Perspeciive | Base | inherit P |
General | Hidden Unes | Visible Unes | Smooth Edges | Vimual incersections | General | HiddenUnes | Visibie Lines | Smouth [dges | Vimual intersections |
& Hidden Lne | |
T

[T Referenced Edges Only
[7] Edges Hidden by Edges
] Imterlering Solids

o Self tadden
[ imnclude Model Eurves
Small Fcnium&m
mhent If Resat | Load Detaus || Load Al Detaus | mhent If Resat | Load Detaus || Load Al Defauits |
ok appy | [ Cancel ok Appy | [ Cancet
FIGUR 10-9 FIGUR 10-10

e Velg mappen “Hidden Lines”

e  Gjgr "Hidden Lines” fra usynlig til streket (“"Dashed”)
e Velg mappen ”“Smooth Edges”

e  Gjgr "Smooth Edges” inaktiv

e  Trykk knappen ”OK”

Du kommer na tilbake til dialogboksen

e Velg den flaten slik at du ser flaten ovenfra “Top”

e Velgskalaentilen

e  Fgr markgren ut i arbeidsvinduet. Du ser na ringen med flaten ovenfra ligge pa musemarkgren
e Plasser bildet gverst til venstre i bildet, og trykk ned MB1 for 3 plassere det
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o Trekk et bildet ut til hgyre og plasser det ved a trykke MB1
e Trekk et bildet ned og plasser det ved a trykke MB1, da skal det se ut som Figur 10-11
e  Trykk en gang pa escape

FIGUR 10-11 FIGUR 10-12

Symmetrilinje

| kilesporet er det en symmetrilinje. Det er viktig a sette opp den, siden den skal malsette plasseringen til

kilesporet.
e Insert = Centerline = 2D Centerline...

Du kommer na inn i dialogboksen ”2D Centerline” (Figur 10-13).

"rfﬁ[:enterline " y
e ——__ .
Type A ',_../" ~

4 Select Object (1) I|I.l' \‘|

Side 2 M

|
: =l /
4 Select Object{1) -¢' /
| \ /
Inherit v \ S
Settings M. N /
L | \ /
[ Ok ] [ Lpply ] [ Cancel ] N\ ~'//
= “\H_ ,/'/

FIGUR 10-13 FIGUR 10-14

e Velg fgrst kant 1 og sa kant 2 Figur 10-12
e Velg fgrst kant 1 og sa kant 2 Figur 10-12
e  Trykk knappen ”OK”

Du kommer na tilbake til arbeidsvinduet i NX.
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Malsetting

Kilesporet skal bli malsatt. Vinkelen til kilesporet i forhold til den horisontale aksen, lengden fra kilesporet
til origo, og bredden til kilesporet.

e Insert > Dimensions = Angular...

Du kommer na inn i dialogboksen ”Angular Dimension”.

(IR VAR
FIGUR 10-15 FIGUR 10-16

e Velg symmetrilinjen til kilesporet og den langt til hgyre pa den horisontale linjen
e  Plasser malsettingen slik som Figur 10-15
e Insert > Dimensions - Parallel...

Du kommer nd inn i dialogboksen ”Parallel Dimension”.

e Velg topplinjen av kilesporet
e  Plasser malsettingen slik som Figur 10-15
e Insert 2 Dimensions = Perpendicular...

Du kommer na inn i dialogboksen ”Perpendicular Dimension”.
e Velg topplinjen av kilesporet og den andre siden av den indre sirkelen

For at malsettingen skal veere pa linje med malsettingen til bredden av kilesporet, sa fér markgren over
malsettingen til bredden av kilesporet, og fgr markgren mot venstre for a plassere malsettingen. Da ser
du det blir en prikkete linje slik det er i Figur 10-16

e  Plasser malsettingen slik som Figur 10-15
e Trykk en gang pa "Escape”, for 3 komme ut av funksjonen “Perpendicular Dimension”.

Du kommer na tilbake til arbeidsvinduet i NX.
Snitt

For & illustrere en del bedre, tar man ofte et snitt av delen. Det kan skje tvers igjennom, eller snitt med
vendepunkt. Dette er godt forklart i Mekanikerpermen.

e Insert 2 View = Section View...

Du kommer na inn i dialogboksen ”“Section View”.
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e  Marker bildet du skal snitte

e  Marker senter av ringen (Figur 10-17)

e Fgr markgren til hgyre i bildet, og plasser snittet der det er plass ved a trykke MB1
e Trykk en gang pa knappen "Escape”, for 8 komme ut av snitt

Du kommer na inn i arbeidsvinduet i NX.

Madlsette snittet

N3 skal du malsette snittet. Dimensjonene som skal malsettes er fire hull, innerkanten, og ytterkanten.
e Insert = Dimensions = Cylindrical...

Du kommer na inn i dialogboksen ”Cylindrical Dimension”.

e Velg nederste og gverste linje (ytterkantene) av ringen

e  Plasser malsettingen slik som Figur 10-18

e Velg nederste og gverste innerkant av ringen

o Trekk markgren over malsetting til ytterkanten, slik at malsettingen kommer pa linje

e  Plasser malsettingen slik som Figur 10-18

e Trykk pa knappen ”"Annotation Editor” i seksjonen “Text” i dialogboksen ”Cylindrical Dimension”
(Figur 10-19)

Du kommer na inn i dialogboksen “Text Editor”.
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e Sett "Appended Text” til "Before” (Figur 10-20)
e  Skrivinn ”4 X” (Figur 10-21)
e  Trykk knappen ”OK”

Du kommer tilbake til dialogboksen ”Cylindrical Dimension”.

e Velg nederste og gverste linje av det gverste hullet
o Trekk markgren over malsetting til ytterkanten, slik at malsettingen kommer pa linje

" N3 vil det komme ”4 X” pa alle malsettinger som skjer. Dermed ma vi ga inn i “Annonation” og fjerne "4 ;
_X”. En annen mulighet for a lage "4 X”, er & trykke MB3, velge "Edit Appended Text” og sa fylle inn.

e Insert - Dimension = Inferred...
Du kommer na inn i dialogboksen ”Inferred Dimension”.
e Trykk pa ”Annotation Editor” i seksjonen "Text”

Du kommer na inn i dialogboksen ”Annotation Editor”.

(&

o  Trykk knappen “Clear”
e Trykk pa knappen "OK

, for & fjerne all notasjon

Du kommer na tilbake til dialogboksen ”Inferred Dimension”.

e  Marker gverste endekant av ringen (Figur 10-22), slik at man far tykkelsen pa ringen
e Trekk den sa opp og plasser den over ringen (Figur 10-23)
e Trykk en gang pa knapenn "Escape” for & komme ut av dialogboksen ”Inferred Dimension”

Du kommer na tilbake til arbeidsvinduet i NX.
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" 0BS: Hvis du skal malsette noe mer, s3 ma du gd inn i "Annotation” og fjerne kommentaren som ble lagt ;
_ til. Ellers vil det komme en kommentar pa alle malsettingene dine.

Fjerne delriss

Na ser du at to av rissene er overflgdig. De gir ingen spesiell ekstra informasjon. Dermed skal de fjernes.

e Marker rammene til de to rissene ved a trykke MB1 pa dem (Figur 10-24).
e Trykk MB3 over en av rammene
o Velg "Delete”

Du kan godt flytte pa snitt ved a holde MB1 nede, dra den dit du vil, for sa og slippe MB1 igjen

FIGUR 10-24
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Isometrisk figur

Siden det na har blitt mer plass, sa skal du sette inn en illustrativ figur.
e Insert > View > Base ...

Du kommer na inn i dialogboksen ”Base View”.

J

o Velg flate = "TFR-ISO” fra seksjonen ” Model View” fra rullgardinen “Model View to Use”
e Plasser den under hovedrisset ved a trykke MB1
e Trykk en gang pa knappen ”"Escape”

Fyll ut tittelfelt
Na skal du fylle ut tittelfeltet. Det blir vist med to eksempler, sa kan du fylle inn resten.
e Insert > Annotation = Note...

Du kommer na tilbake til dialogboksen “Note” (Figur 10-25).

w[Note [9]—|%
Origin a
¥ Specify Location @
| atignment v
[ Annotation view v
Leader v
Text Input o
Edit Text v Dat Konebr./Tegnet Gock et ———
Formatting v
ropapts 111 NTNU - 1PM
Erskatn F 7
symbols v
Import/Export v
settings v
Harwisning? Berean
=riing Bereg
Close-
FIGUR 10-25 FIGUR 10-26

e  Skriv”1:1” inn i seksjonen “"Text Input”

e Plasser ”1:1” inn i "Maalestokk” i tittelfeltet (Figur 10-26)

e Byttut”1:1” med ”@ving 18B”

e Merk “@ving 18B” ved a holde MB1 nede og trekke markgren over, slipp MB1 nar teksten er
merket

e Plasser "@ving 18B” i dokumenttittel feltet ved a trykke MB1

e  Fyll sa ut de resterende tittelfeltene.

* Du kan justere skriftstgrrelse ved & g& inn i seksjonen ”Settings” og trykke p& knappen ”Style”. | =
_ dialogboksen “Style” kan du gjgre om skriftstgrrelsen ved & forandre ”Character Size” med en hgyere
~ eller lavere verdi.

_—— e —_— e — e — e — e — e — e — e — e ——_ e ——_— e —— e ——_ e —— e ——_ e —— e — e —

Avslutt

e  File = Save (Ctrl+S)
e File > Close = All Parts...
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